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1. [bookmark: _Toc64634031]Overview
[bookmark: _Toc26939][bookmark: _Toc26691] 
1.1. [bookmark: _Toc64634033]A Brief Introduction to the SeaThinking Simplified Version Software

[bookmark: _Toc64634034] Software Introduction
software supports Unicode and can run in several operating systems of the Microsoft Windows series, including Windows 7, Windows 8 and Windows 10. All the following descriptions in this manual are applicable to the currently predominant Microsoft Windows 7 operating system by default.
SeaThinking simplified version software supports Unicode and can run in several operating systems of the Microsoft Windows series, including Windows 7, Windows 8 and Windows 10. All the following descriptions in this manual are applicable to the currently predominant Microsoft Windows 7 operating system by default.
SeaThinking Simplified software can run on a variety of Microsoft Windows operating system platforms，
software is an simplified version of SeaCAD 5.X，，。
SeaThinking simplified version software is an simplified version of SeaCAD 5.X, which mainly simplifies the advanced functions that are not commonly used, and enhances the stability of the software.

is installed in a green way: extract the installation package into any directory in the hard disk, and then double click the SeaCAD.exe under the directory to run the software. See the following figure.
SeaThinking simplified version software is installed in a green way: extract the installation package into any directory in the hard disk, and then double click the SeaCAD.exe under the directory to run the software. When the software starts, it will automatically detect the marking card device， See the following figure.

[image: ]
，，
No laser control board detected. Please check the connection line between the device and the computer and power on the device again


No board detected card
[image: ]
  http://www.basiliang.com
Changsha SeaThinking Info. Tech. Co., Ltd.  http://www.basiliang.com
Fig.1-1 Software Initial
[bookmark: _Toc19376][bookmark: _Toc64634035]Software Function
Main functions of this software:
Software has the following main functions：
●   User can Design their graphics freely pattern .
●   Supports multiple document editing, multiple documents, multiple cards, and multiple laser types marking simultaneously.
· Supporting all the fiber lasers, CO2 lasers and end-pumped lasers in the market. The parameters, such as the electric current, impulse frequency and duty ratio, can be set and adjusted through the software according to different laser types.
· Supporting the single red light marking pointer.
    Support separate red light marking indication.
· Providing the software access control to prevent the parameters from being modified at random.
Software the Providing use jurisdiction control to prevent the parameters from being modified at random.
· Provide basic IO control functions: enabling your machine to easily realize automatic control through the port control.
Provide basic IO control function: through port control,enabling your machine easily implementation automation control。
· Provides manual correction, and nine point correction methods to obtain extremely accurate 2D marking results effect.
· Providing the expansion axis function: supporting the expansion axis to rotate according to the angle and such as rotary marking.
Provide extended axis function：supporting extended axis to rotate according to the angle，such as rotary marking.
· Supporting the hatching operation: providing rectilinear hatch and round hatch at any angle and in a crossed manner, with the adjustable margin, border, space, etc.; supporting the hatching combination of four layers at most, with parameters of each layer set independently.
Support filling operation: provide line and ring filling, can be filled at any angle, cross filling, margin, border, spacing and other adjustable. Support up to four layers of filling combination, each layer can set parameters independently




· Providing the variable text function: fixed text, serial number, data code, time, TCP/IP communication, serial communication, SQL database, etc.
Providing the variable text function: fixed text, serial number, date of , time, TCP/IP communication, serial Interface communication, SQL database, etc.
· Supporting 256-layer marking parameters: supporting the parameters of each layer to be set randomly to easily realize multi-parameter marking.
· Supporting image files such as PLT, DXF, BMP, JPG and JPEG.
· Supporting the common 1D/2D barcodes, such as Code39, EAN, PDF417 and DATAMATRIX DM
· Providing the text input function and supporting various types of fonts, such as True Type, Jsf, barcode font and fonts added by the user (such as Dot Matrix Font).
   Provide text input function, support True Type fonts, single line fonts, bar code fonts, and Autonomy add (dot matrix fonts, etc.) fonts.
· Supporting the dynamic file marking. When the text and graphs are marked, the filename is fixed, but the file content will be changed.
· Providing powerful editing function: supporting the arc arrangement of characters, random any graph drawing/editing, uncombining/combining, grouping/ungrouping, undoing/redoing, plastic, etc. 
· Providing the simulation function: the graph marking tracks can be previewed before marking operation.
   Providing the simulation function: You can preview the marking trajectory of the graph before marking operation
· Supporting secondary development: providing the SDK secondary development library, supporting the user to customize the development, expanding the functions of the existing marking system and meeting the user’s requirements in special applications.
· 12，
· Providing up to 12 kinds of language support to meet most needs



[bookmark: _Toc26907][bookmark: _Toc64634036]Interface Introduction
· Starting initial interface
The interface (Fig. 1-2) appears when the program runs, and meanwhile the initial operations take place in the background. 
Starting to run the program, startup interface (Figure 1-2) is displayed, and the program initializes in the background.
[image: C:\Users\loop\Desktop\1.bmp1]
Fig.1-2 Program Starting Interface
· Main interface
[image: C:\Users\loop\Desktop\0714\1.bmp1]
Fig.1-3 Main Program Interface
[bookmark: _Toc64634037][bookmark: _Toc24019]About  User’s Manual 
[bookmark: _Toc64634038]About SeaThinking Simplified Version User’s Manual

[bookmark: _Toc2162][bookmark: _Toc64634039]Contents Arrangement
This manual will introduce the usage of  according to the order of the menu bar in the main interface, It includes ten main menus, including file, draw, edit, modify, special, status bar, laser, view, galvanometer correction, help, object bar and marking control bar.
This manual will introduce the usage of SeaThinking simplified version software according to the order of the menu bar in the main interface, It includes ten main menus, including file, draw, edit, modify, special, status bar, laser, view, galvanometer correction galvo, help, object bar and marking control bar.

[bookmark: _Toc24367][bookmark: _Toc64634040]Announcement  Other declarations
· Other products and company names involved in this manual may be the trademark of the corresponding owner.
   Due to the actual operation mode and function settings caused by software upgrade, the contents of this manual may not be updated in time. In case of any inconsistency with this manual, the software shall prevail.
· Other product and company names mentioned herein may be the trademarks of their respective owners.
[bookmark: _Toc416973408][bookmark: _Toc64634041][bookmark: _Toc408402471][bookmark: _Toc17500]Instructions of Software Installation
· This software is green software and can run immediately after extracted.
· When the software starts and the reminder of “xxxx.dlll cannot be found” appears, carry out vcredist_x86_2010.exe to install the system patch.
[bookmark: _Toc12087][bookmark: _Toc13988][bookmark: _Toc64634042]2. File Menu
The File Menu is used for common file operations, such as “New”, “Open” and “Save”, as well as functions like system parameter setting and common graph library maintenance. See Fig. 2-1.
[image: C:\Users\loop\Desktop\0714\2.bmp2]
 New 
 Open
 Close
 Save
(A)...  Save As (A)...
 Vector File
  Image File
Ctrl + P  Print Ctrl + P
（m）... Get Scan Image (m)...
  System Parameter

Fig. 2-1 “File” Menu
[bookmark: _Toc30891][bookmark: _Toc19698][bookmark: _Toc64634043]2.1.New(N)
“New” Submenu is used for creating a blank workspace to construct objects, and its shortcut key is “Ctrl+ N”. 
The icon of “New” in the Toolbar is [image: ]. Clicking on this icon will achieve the same operation.
“New” Submenu corresponding toolbar Icon for [image: ]. Clicking on this icon will achieve the same operation.

If you move the mouse cursor onto the icon mentioned above and keep it for a while, a piece of prompt information (Tool-tip) will appear, which briefly explains the function of this icon, and there will also be some detailed explanations appearing in the Status Bar in the bottom of the main window. And if you move the mouse cursor onto “New” in File Menu, only the detailed explanations will show in the Status Barr, but the prompt information will not.
When you move the mouse pointer to the toolbar to create a new icon and pause a little, the system will display a prompt message to briefly explain the function of the icon, and the status bar below the main interface window will display a slightly detailed explanation of the function. If you move the mouse pointer over the new submenu in the menu bar, only a detailed explanation will appear in the status bar, and the prompt will not appear.
[Reminder: in thesoftware, each icon in the Toolbar has a function of showing brief prompt information and the Status Bar has a function of displaying detailed explanations. Also, each icon has a corresponding menu item, and both the two ways carry out the same function. The User’s Manual will not mention it again in the following chapters.]
[Reminder Tips: in the SeaThinking simplified version software, each icon in the Toolbar has a function of showing brief prompt information and the Status Bar has a function of displaying detailed explanations. Also, each icon has a corresponding menu item, and both the two ways carry out the same function. The User’s Manual will not mention it again in the following chapters.]

[bookmark: _Toc17202][bookmark: _Toc28372][bookmark: _Toc64634044]2.2.Open(O)
“Open” is used for loading a saved “.orz” file, and its shortcut key is “Ctrl + O”. When you click “Open”, the software will pop an open-file dialog box (Fig. 2-2) to ask you select the file you want to open. See fig 2-2.
“Open” Submenu Used to open an .orz file saved on your hard disk, Its shortcut key is Ctrl + O. When the open submenu is selected, system A dialog box will appear to open the file (Fig. 2-2). Ask you to select the file you want to open. When you select a valid .orz file, A preview graphic of the file is displayed below the dialog box.
[image: C:\Users\loop\Desktop\9.jpg9]
Fig. 2-2 “Open” Dialog Box
Toolbar icon for the open submenu is [image: ].
 Open
（I）：Look in (I): 
 Work Images
 Name
 Date
 Type
 Size
 Marking
（）.orz   Warning (No Reference).orz
 Open
 Cancel 
 Display Preview
[bookmark: _Toc10409][bookmark: _Toc19454][bookmark: _Toc64634045]2.3.Save(S) Save As(A)
“Save” is used for saving the current state of a mark Document to disk. “Save As” is used for writing the current mark Document to disk by another name. The file can be saved in either of these two ways.
The save submenu saves the drawing with the current file name, and the save as submenu saves the drawing with another file name. Both realize the function of saving files.
If the current Document has already been named, “Save” is selected to save it under the name that was used for opening the file, or the software will prompt the user to choose a destination path and type a name. Whether the current file is named or not, the “Save As” dialog box (Fig. 2-3) will appear to ask for a new name to save the file, and the previous file will not be overwritten.
If the current file already has a file name, the Save command saves the currently drawn drawing with that file name. Otherwise, the save file dialog box will pop up, asking you to choose the path to save the file and provide the file name. No matter whether the current file has a file name or not, the save as command will pop up the Save As dialog box (Figure 2-3), asking you to provide a new file name for saving to avoid the old file being overwritten.
[image: C:\Users\loop\Desktop\5.png5]
Fig. 2-3 “Save As” Dialog Box
The icon of “Save” in the Toolbar is [image: ].
 Save As
 Library
 Documents
 Facorites Favorites
 Downloads
 Desktop
 Last Visited Location
 Library
 Videos
 Images
 Documents
 Document Libraries
：2  Including: 2 Positions
：  Arrangement: Folders
 Name
 Modified Date
（N）：.orz  File Name (N): Untitled.orz
（T）:  Save Type (T):
 Hide Folders
  Save 
 Cancel
[bookmark: _Toc64634046][bookmark: _Toc4099][bookmark: _Toc1174]2.4.Print	
Print is used to print current image and its shortcut key is “Ctrl+ P”.
The shortcut key for printing is Ctrl + P, which is used to print the current drawing.
[bookmark: _Toc64634047]2.5. Obtain Get scanned image (m)
‘Obtain Scan Image’ submenuis used to get images from specific external devices. Selecting this command will bring up the dialog box shown in Figure 2-4. Requires the selection of an external device (the listed devices are legitimate drivers already installed on your computer). When an external device is selected, the corresponding device image processing dialog box appears. You can select the corresponding image input. (The dialog box varies depending on the device. Please refer to the corresponding device operating instructions.)
[image: C:\Users\loop\Desktop\2.png2]
Fig.2-4 Obtain Scan Image Get scanned image

 Select Source
： Source:
  Selected
  Cancel
[bookmark: _Toc64634048]2.6.System Parameter System configs (P)
“System Parameter” configures the software. When it is selected, a dialog box as shown in Fig. 2-4 will appear, and you can set the unit the software uses, the color displayed, the work space’s parameter, user manager and other parameters.
“System configs” submenu is used to set the system parameters. Select "system parameters" menu and a dialog box as shown in Figure 2-5 will pop up. In this dialog box, you can set general parameters of software, displayed color, parameters related to working range, user management and other parameters.
[image: C:\Users\loop\Desktop\0714\3.bmp3]
Fig. 2-5 “System Parameter” “System configs” Window
The icon of “System Parameter” ” System configs” in the Toolbar is [image: ].
  System Parameters System configs
 General
 Color and Style
 Workspace
 Custom Keyboard Shortcuts
 Auto Save
 Move-Rotate
 User Administration
 Language
  Horizontal Alignment Spacing
  Vertical Alignment Spacing
  Horizontal Paste Offset
  Vertical Paste Offset
  Smoothing Coefficient
（：，，）
(Note: The smaller the coefficient, the more points, the smoother)
  Display Grid
  Grid Spacing
IO  Input IO Mask
IO  Output IO Mask
，  Run the program when the main program starts 
  
Create an empty document automatically when the program starts
，  
Run the program when the main program is closed

  Multi-card marking exits the window automatically 
 Maximum Number of Devices
  OK
  Close
[bookmark: _Toc8726][bookmark: _Toc23814][bookmark: _Toc64634049][bookmark: _Toc416973414]2.6.1.General Conventional
In “General” , common parameters can be configured.
In Conventional, mainly set some general parameters
“Paste X” and “Paste Y”: refer to the new object’s offsets with respect to previous one (pasted object) when the Copy/Paste function is used, as shown in Fig. 2-6:
Horizontal paste / vertical paste offset: specifies the offset of the, newly generated object (be pasted object) relative to its original position when you use the copy / paste function. As shown in Figure 2-6:
[image: ]
Fig. 2-6 Original Graph and Copied and Pasted Graph
“Smoothing Parameter”: controls the smoothness of the vector diagram generated by the software.
“Grid”: shows or hides the grid.
“Grid Space ”:：adjusts the distance in grid.
“Grid spacing ”： Distance between gridlines


“Execute when SeaCAD Starts，Run SeaCAD program”/“Execute when SeaCAD Finish，Execute when SeaCAD Starts，Run SeaCAD program”: start the executable programs provided by the third party to realize some relevant operations. 
Open a new file when SeaCAD Starts：a new file named "SeaCAD1" is automatically created after the software is opened.
“Input IO Mask”: sets the input port supported by the current software.
“Output IO Mask”: sets the output port supported by the current software.
[bookmark: _Toc7038][bookmark: _Toc16230][bookmark: _Toc64634050]2.6.2.c
“Color” is used for setting the color of background, workspace, guide line centerline and grid, etc. Double clicking the color stripe could change the corresponding color. See Fig. 2-7.
      [image: C:\Users\loop\Desktop\0714\444.bmp444]
    Fig. 2-7 Color Setting

  System Parameters
 General Conventional
 Color and Style
 Workspace 
 Custom Keyboard Shortcuts
 Auto Save
 Move-Rotate
 User Administration
 Language
Background
： Grid:
 Guide Line auxiliary Line
 Center Line
UI cc
  OK
  Close










[bookmark: _Toc25360][bookmark: _Toc64634051]2.6.3.Worksp ace working area 
“Workspace working area” is used for setting various parameters in the operating area, enabling the user to customize them based on his habits. See Fig. 2-8.
     [image: C:\Users\loop\Desktop\0714\11.bmp11]
Fig. 2-8 Workspace working area Setting

  System Parameters
 General
 Color and Style
 Workspace
 Custom Keyboard Shortcuts
 Auto Save
 Move-Rotate
 User Administration
 Language
 Display Non-marking Metafile
 Display Workspace
 Display Circular Interval
 Display Center Cross Line
 Lower Left Corner
X  -50   X  -50mm
Y  -50   Y  -50mm
  Size
  100  Width 100mm
  100  Height 100mm
  OK
  Close














[bookmark: _Toc64634052][bookmark: _Toc25271]2.6.4.  Custom Keyboard Shortcuts 
	。
It is used to set the shortcut keys corresponding to various functions of the software.
      [image: C:\Users\loop\Desktop\0714\12.bmp12]
2-9 Custom Keyboard Shortcuts

  System Parameters
 General
 Color and Style
 Workspace
 Custom Keyboard Shortcuts
 Auto Save
 Move-Rotate
 User Administration
 Language

	
Functions
	
Keyboard Shortcuts
	
Disable When Editing Text

	
Single Card Marking
	F2
	No

	
Single Card Red Light
	F1
	No

	
Parameter Settings
	F3
	No

	
Reset Workspace Layout
	Ctrl + Alt + R
	No

	
Multi-card Marking
	[Not Set]
	No

	
New File
	Ctrl + N
	No

	
Open File
	Ctrl + O
	No

	
Save File
	Ctrl + S
	No

	
Save File As
	Ctrl + Alt + S
	No

	
Close File
	Ctrl + W
	No

	
Exit Program
	[Not Set]
	No

	
Toggle Snap Network
	F7
	No

	
Toggle Snap Guide Line
	F8
	No

	
Toggle Snap Object
	F9
	No

	
Delete Selected Metafile
	Delete
	Yes

	
Metafile Move Up
	Up
	No

	
Metafile Move Down
	Down
	Yes

	
Metafile Move Left
	Left
	Yes

	
Metafile Move Right
	Right
	Yes

	
Metafile Move Up in Large Scale
	Shift + Up
	Yes

	
Metafile Move Down in Large Scale
	Shift + Down
	Yes

	
Metafile Move Left in Large Scale
	Shift + Left
	Yes

	
Metafile Move Right in Large Scale
	Shift + Right
	Yes


  Use Default Settings
  OK
  Close

[bookmark: _Toc64634053]2.6.5. Auto Save
“Auto Save” is used for setting the interval time between two automatic saves, so as to efficiently prevent missing file in case of any emergency (such as power failure or dead halt). According to the set interval time, the current data is saved in the file named “autosave.orz’ in SeaCad’s directory. See Fig. 2-9.
        [image: C:\Users\loop\Desktop\0714\13.bmp13]
Fig. 2-10 Auto Save Setting

  System Parameters
 General
 Color and Style
 Workspace
 Custom Keyboard Shortcuts
 Auto Save
 Move-Rotate
 User Administration
 Language
5  Auto Save Every 5 Minutes
AutoSave.orz
Save the current data to the AutoSave.orz file in the program directory every specified time interval

[bookmark: _Toc19326][bookmark: _Toc64634054]2.6.5.Move-Rotate
    Nudge Distance fine adjustment： refers to the distance that the selected object moves each time when the direction key is pressed, if the direction keys of the keyboard are used for moving the graphs.
    Big Nudge Scale Large adjustment: If the distance to be adjusted is long, synchronously pressing direction keys and “shift” key will enable the selected object to move for a distance of Nudge Distance*Big Nudge Scale Large adjustment. 
Rotate Angle: refers to the angle the object rotates each time when direction keys and “ctrl” key are pressed together.
Object’s Origin Homing method: determines which point of the object should be put on the origin when the “Put to Origin” function is used. divides each graph into 9 position points (0-8). “Object’s Origin” can be set by positioning the graph accurately at the user’s will. Fig. 2-9 shows the origin setting based on Position 1. After the graph is drawn in the workspace of the software, click [image: 1] (Put to center) button: 
[bookmark: _Hlk31884665]Object’s Origin Homing method: determines which point of the object should be put on the origin when the “Put to Origin” function is used. SeaThinking simplified version software divides each graph into 9 position points (0-8). “Object’s Origin” can be set by positioning the graph accurately at the user’s will. Fig. 2-9 shows the origin setting based on Position 1. After the graph is drawn in the workspace of the software, click [image: 1] (Put to center) button: 
[image: IMG_256]
Fig. 2-11 Example of “Put to Origin” “Homing method”

[bookmark: _Toc9072][bookmark: _Toc19651][bookmark: _Toc64634055]2.6.6.User Manager Management
· It is used for setting whether the user password shall be input to use the current software, as shown in Fig. 2-11.
When “Enter the Password before Using” is selected, the system is configured with one administrator, one designer and one Draftsman by default, but the user can add operators.
，。
The administrator has the permission to use all functions of the software, and must not change the permission.
。
The permissions of other users can be set by themselves.
       [image: ]
     Fig. 2-12 User Manager Management

  System Parameters
 General
 Color and Style
 Workspace
 Custom Keyboard Shortcuts
 Auto Save
 Move-Rotate
 User Administration
 Language
  You must enter the password when you use the software
 User
 Administrator
 Designer
 Add
 Modify
 Delete
 Save Permission Settings
	
General Processing
	
Yes
	
No

	
Create File
	
Yes
	
No

	
Edit File
	
Yes
	
No

	
System Settings
	
Yes
	
No

	
Parameter Settings
	
Yes
	
No

	
Open File
	
Yes
	
No

	
Save File
	
Yes
	
No


  OK
  Close

[bookmark: _Toc20336][bookmark: _Toc64634056]2.6.7.Language
· [bookmark: _Toc12663][bookmark: _Toc21789]It shows the language package installed in your computer. You can use it to change the language used in the interface of . The change will not take effect until the software is restarted next time. 、，，11。
· It shows the language package installed in your computer. You can use it to change the language used in the interface of SeaThinking simplified version software. The change will not take effect until the software is restarted next time. It has Chinese simplified, Chinese traditional, English, Korean and other 11 language packages by default.

[bookmark: _Toc64634057][bookmark: _Toc12009][bookmark: _Toc1527][bookmark: _Toc416973421]2.7.Common Graph Library  ()
This function can import the graphs frequently used to the common graph library for use at any moment. The specific procedures are as follows:
1. Save the graph library file
Draw or import the graph which you want to save in the common graph library in the workspace, select that graph, open the “File”/“Common Graph Library” dialog box, then click “New Graph Library” to enter the name of the new graph library in the “New Graph Library” dialog box, and click “OK”. as shown in Fig. 2-13:
First of all, draw or import drawings in your workspace that you want to store in a common library,
[image: ]
2-13 “”
Figure 2-13 “Common Graph Library” Dialog Box

 Common Graph Library
 Graph Library Name
 Image Preview
：
Tip: Hold down the left mouse button to select the desired graphs and drag them to move to the workspace
 Common Graphs
 New Graph Library
 Please Enter the Library Name
  OK
 Cancel
 New Graph Library
 Delete Graph Library
 Add Image
 Delete Image 
When the graph library is created, add the graph to be saved. Select the graph in the workspace, click “Add Graph” to enter the graph name, and click “OK” to save the graph selected in the work pace in the “Common Graph Library”.







2. Copy the graph from the graph library
If the graph in the graph library is to be copied, open the common graph library and drag the graph to be used to the workspace by pressing the left mouse button.as shown in Fig. 2-14:
        [image: ]
         Fig.2-14 Copy the graph from the graph library
 Common Graph Library
 Graph Library Name
 Image Preview
：
Tip: Hold down the left mouse button to select the desired graphs and drag them to move to the workspace
 Common Graphs
 New Graph Library
  OK
 Cancel
 New Graph Library
 Delete Graph Library
 Insert Image
 Delete Image 
[bookmark: _Toc64634058][bookmark: _Toc416973422]2.8.Recent File List
Below “System Parameter”, a list is displayed to show the files recently opened by the user. If the user has never opened/saved any “.orz” file, such a list will not appear.
[bookmark: _Toc25915][bookmark: _Toc31784][bookmark: _Toc64634059]2.9.Exit (X)
It is used for exiting the  software. If any file is not saved, the system will ask you whether to save it. 
It is used for exiting the SeaThinking simplified version software. If any file is not saved, the system will ask you whether to save it.

[bookmark: _Toc12340][bookmark: _Toc10898][bookmark: _Toc64634060][bookmark: _Toc416973424]2.10.Object List window
Object List is in the left side of the main interface of  software, as shown in Fig. 2-14: 
Object List is in the left side of the main interface of SeaThinking simplified version software, as shown in Fig. 2-14:
[image: ][image: 2]
Fig. 2-14 Object List
 Object List Window
	Name
	Type
	Marking

	1 Rectangle 1
	Rectangle
	

	1 Text 1
	Text
	

	（）1 Circular (Arc) 1
	（）Circular (Arc)
	


Note: during marking, the system will follow the order in the object list (from top to bottom) to mark the listed objects（3D）。
Note: during marking, the system will follow the order in the object list (from top to bottom) to mark the listed objects. (Except for 3D metafiles). 
The user can rearrange the list by directly dragging the object or through the right key.
The user can double click the object name to rename it.
[bookmark: _Toc15142][bookmark: _Toc18262][bookmark: _Toc64634061][bookmark: _Toc416973425]2.11.Object Properties Toolbar Window
Object Properties Toolbar Window is displayed in the left side of the main interface of the software, as shown in Fig. 2-15.
[image: ]
Fig. 2-15 Object Properties Toolbar Window

 Object Property Box
 Location
 Size
 Array
 Apply
 Fillet Degree
 All Edge Fillet
X Position: the X coordinate of the selected object. It can indicate the coordinate of the object’s left bottom corner or its center. The coordinate data button [image: ] is used for setting the specific content of the coordinate.
X Position: Represents the X coordinate of the currently selected object，This coordinate can be specified as the coordinate of the lower left corner of the object，You can also specify coordinates for the center of an object，Through coordinate information button，[image: ]To set the specific meaning of position coordinates.
Y Position: the Y coordinate of the selected object. It can indicate the coordinate of the object’s left bottom corner or its center. The coordinate data button [image: ] is used for setting the specific data of the coordinate.
X Position: Represents the Y coordinate of the currently selected object，This coordinate can be specified as the coordinate of the lower left corner of the object，You can also specify coordinates for the center of an object，Through coordinate information button，[image: ]To set the specific meaning of position coordinates.
Z Position: Said that the current the Z coordinate of the selected object.
X Size: Said that the current the width of the selected object.
Y Size: Said that the current the height of the selected object.
[image: ]: locks the current length/width ratio of the selected object. If the user changes X and Y Sizes, the system will keep the length/width ratio of the new size unchanged.
Coordinate Data information Button[image: ]: determines specified whether X position and Y position correspond to the coordinates of the left bottom corner or center of the object or other given positions. When the user clicks this button, a dialog box will appear to ask the user to select the position corresponding to the coordinate. The coordinate data displayed currently indicate that X Position and Y Position correspond to the coordinates of the object’s left bottom corner.
Array [image: ]: copies the current object and arrange them to the destination by dealing with the dialog box as shown in Fig. 2-16:
Array [image: ] ：Copy the current object to the specified location, and the operation dialog box is as shown in Figure 2-16:
[image: C:\Users\loop\Desktop\0714\15.bmp15]
Fig. 2-16 Array Operation Dialog Box

 Array
Array
 Quantity
 Increment
 Use Spacing Method
  OK
  Close

Increment: the space between rows/columns, given by the user.
Increment: Refers to the user specified row spacing and column spacing.
Fig. 2-17 shows the object’s situation when X=2 and Y=3.
Figure 2-17 is the Array Number， X=3、Y=2 object situation
[image: ]
Fig. 2-17 Array Operation Result
[image: ]: sets the array’s row as marking precedence.
     Indicates the array direction is horizontal priority
[image: ]: sets the array’s column as marking precedence.
     Indicates that the array is unidirectional.
[image: ]: refers to the unidirectional marking.
     Indicates that the array is a two-way array.
[bookmark: _Toc9277][bookmark: _Toc31140][bookmark: _Toc64634062]3. Edit Menu
The “Edit” menu carries out the editing operation of a graph, as shown in Fig. 3-1.
[image: C:\Users\loop\Desktop\0714\16.bmp16]
Fig. 3-1 “Edit” Menu

 Edit
 Draw 
 Modify
 View
 Undo
 Redo
 Cut
 Copy
 Paste
（A） Select All (A)
 Select Invert
 Delete
 Combine
 Uncombine
 Group
 Ungroup
 To Curve
 To Dashed Line
 Offset
 Ungroup Text
[bookmark: _Toc64634063][bookmark: _Toc416973427]3.1.Undo (U)/Redo Recovery (R)
During graph editing, if the current operation is not satisfying, “Undo” can be used for undoing current operation and bring the previous operation back; after the current operation is undone, “Redo” can be used for redoing the undone operation. This is one of functions most frequently used in editing.
The icon of the “Undo” menu in the Toolbar is [image: ], while the icon of the “Redo Recovery” menu in the Toolbar is [image: ]. Similar to most software, those two operations have their corresponding shortcut keys, i.e. Ctrl+Z and Ctrl+Y respectively.
[bookmark: _Toc20236][bookmark: _Toc23602][bookmark: _Toc28288][bookmark: _Toc64634064][bookmark: _Toc416973428]3.2.Cut (T), Copy (C) and Paste (P)
“Cut” will delete the selected graph and copy it to the clipboard of the system. Then “Paste” will copy the graph in the clipboard to the current graph. “Copy” will copy the selected graph to the system clipboard and keep the original graph.
The shortcut keys of “Cut”, “Copy” and “Paste” are Ctrl+X, Ctrl+C and Ctrl+V respectively. 
The offset of the pasted graph position with respect to the original graph position is determined by “Paste X” and “Paste Y” in “General” of “System Parameter”.
The position of the pasted figure and the position deviation from the original figure are determined by the paste displacement in the conventional parameters of the system parameters
[bookmark: _Toc9783][bookmark: _Toc21483][bookmark: _Toc22402][bookmark: _Toc64634065][bookmark: _Toc416973429]3.3.Combine/Uncombine 
[bookmark: _Toc64634066]Combination/ Separation Combination
“Combine Combination” will ignore all the selected objects’ original properties and combine those objects into a new curve object. This combined graph, like other graphs, can be selected, copied, pasted and its properties can be set. For example, when the original graph is a circular or a rectangular, but the graph after “Combine Combination” operation is dealt with as a curve and will be transformed into a curve after “Uncombine Separation Combination” operation.
“Uncombine” will get the combined object back to separate curves.
“Separation Combination” Restore combination objects to individual curve objects
The icon of “Combine” in the Toolbar is [image: ], while that of “Uncombine” is [image: ]. Their shortcut keys are Ctrl+L and Ctrl+K respectively.
“Combination” The toolbar icon corresponding to the menu is[image: ],“Separation Combination” The toolbar icon corresponding to the menu is[image: ]. Their shortcut keys are Ctrl+L and Ctrl+K respectively.
[bookmark: _Toc25455][bookmark: _Toc64634067][bookmark: _Toc416973430]3.4.Group/Ungroup Separation Group
“Group” will keep the selected objects’ original properties and make them into a new object, and this new graph, like other graphs, can be selected, copied and pasted, and its properties can be set. 
For example, the original graph is circular or rectangular, but the graph after “Group” operation will be dealt with according to the original properties and it will be restored to the original graph, with properties unchanged, after “Ungroup Separation Group” operation.
“Ungroup” will turn the object which has just been grouped into previous situation.
“Separation Group” Restore the objects of the group to the state before the collection.
The icon of “Group” in the Toolbar is [image: ], while that of “Ungroup Separation Group” is[image: ]. Their shortcut keys are Ctrl+G and Ctrl+U respectively.
[bookmark: _Toc17723][bookmark: _Toc64634068][bookmark: _Toc416973431]3.5.To Curve/Multi-line Segment  Turn to curve
This function is to remove the properties of the selected graph and transform it to a curve or multi-line segment.
Remove the attributes of the selected graphic object and turn it into a curve object.
[bookmark: _Toc9868][bookmark: _Toc28125][bookmark: _Toc64634069][bookmark: _Toc16331][bookmark: _Toc416973432]3.6. Turn To a Dashed Line 
This function is to transform the vector graph to a dashed graph for marking, as shown in Fig. 3-2:
[image: ]
Fig. 3-2 “Turn to a Dashed Line”
The user has to set the length of the short line and the space between lines, and then click “OK” to transform the vector graph into a dashed one.
 To Dashed Line
  OK
 Cancel
 Line Length
 Interval
[bookmark: _Toc64634070][bookmark: _Toc30576][bookmark: _Toc31381]3.7.Offset
	。
After clicking the offset, an additional operation bar will appear on the top of the object list window.
[image: ]
 1  Offset Distance  1 mm
 Delete Old Curve
 Object List Window
SeaCAD1
。3-3：
Offset the drawn vector graphs according to the offset distance. The options are shown in Figure 3-3 on the left:
Offset dist distance：The distance between the old curve and original curve.
            Refers to the distance between the offset figure and the original figure.
Del Old curve：Whether to keep the original graphics. Unchecked means to keep the original graphics. Check to remove the original graphics and keep only the offset.

[bookmark: _Toc64634071][bookmark: _Toc416973433] 3.8.Ungroup Text Separate text
[bookmark: _Toc24844][bookmark: _Toc4068]Ungroup the character text string into several texts, each of which contains only one character.
Separating character text string into multiple text objects that contain only one character
[bookmark: _Toc64634072][bookmark: _Toc20197]3.8.Ungroup Text
Ungroup the character text string into several texts, each of which contains only one character.
[bookmark: _Toc30339][bookmark: _Toc64634073][bookmark: _Toc416973434]3.9Hatch Filling 
“Hatch Filling ” is used for hatching a given graph. The graph to be hatched must be a closed curve.
The icon of “Hatch Filling” in the Toolbar is [image: ]. When it is clicked, a dialog box will appear, as shown in Fig. 3-4.
[image: C:\Users\loop\Desktop\0714\17.bmp17]
Fig. 3-4 “Hatch Filling” Dialog Box

 Hatch
 Enable Contour
 Contour First
 Hatch
  OK
  Close
 Keep the Independence of Hatch Objects
 Enable
 Type
 Object Overall Calculation
 Go Around the Edge Once 
 Cross Hatch 
 Fast Hatch
 Pen Number
 Angle
    0.06  Line Spacing    0.06mm
      1  Quantity     1
   Evenly Distributed Hatch Lines
      0  Edge Distance      0mm
  0  Start Offset      0mm
  0  End Offset      0mm
  0  Linear Indentation      0mm
  0  Number of Boundary Rings  0
    0.5  Ring Spacing    0.5mm
  Auto Rotation Angle Hatch
 Delete
 Dismiss Group When Deleting
Mark Enabling Contour: determines Express whether to show and mark the contour of the original graph, namely, whether the hatched Filling graph keeps the original contour.
Contour Precedence: indicates that the contour is marked first and then the hatch line is marked when “Mark Contour” is clicked.
Contour prior : Indicates that in the case of enabling contour, the contour is marked first and then the filling line is marked
Hatch 1 / Hatch 2 / Hatch 3 / Hatch 4: indicates that there can be three sets of independent hatch parameters for hatch calculation. The crossed hatch at any angle can be realized and each kind of hatch can support four types of hatch to perform marking (four types of hatching are: unidirectional/bidirectional/ring/optimized bidirectional hatch, as shown in the following).
Filling 1 / Filling 2 / Filling 3 / Filling 4: Four sets of unrelated filling parameters can be used for filling operation at the same time，It can achieve any angle of cross filling and each filling can support processing with five different filling types。（The four types of filling are: one-way filling, bow filling, circular filling, optimized two-way filling and two-way filling. See the following for details.）
Enable: determines whether to permit the validity of the current hatch parameter.
All Cal object overall calcul: serves as an optimized option. If it is selected, all the mutually exclusive objects will be calculated as a whole during hatch calculation, which will speed marking up on certain occasions. (If it is selected, the computer’s calculation may slow down), If it is not selected, each independent area will be calculated separately.
For ease of description, we now give a special example to illustrate this feature.
For example: draw three rectangles, line distance is 1mm, angle is 0
Draw three independent rectangles in the workspace, filling line distance is 1mm, angle is 0
1、 Do not click ‘All Calc’, system will mark as the order in object list, mark 	hatch line in the first rectangle then mark hatch line in the second rectangle, and so on.as shown in Fig. 3-5:
1、Do not check "object overall calculation": the machining order in the object list will be followed during machining ，Mark the filling lines one by one, that is, mark the filling diagram of an object first and mark the next. as shown in Fig. 3-5:

[image: 1-4]
Fig.3-5 Do not click ‘All Calc’
Fig.3-5 Do not check "object overall calculation"
2、 Click ‘All Calc’, mark all the hatch line at one time, mark all the hatch that on the same line.as shown in Fig. 3-6:
2、Check "object overall calculation": mark all the filling lines in one time during machining, that is, mark the filling lines in the same line of several objects together. as shown in Fig. 3-6:
[image: 1-5]
Fig.3-6 Click ‘All Calc’
Fig.3-6 Check "object overall calculation"
Type of Hatch Type filling：
[image: ]Unidirectional Hatch: the hatch lines will be marked from left to right.
[image: ]Unidirectional filling: Fill lines always fill from left to right. As shown on the left of figure 3-7.
[image: ]Bidirectional Hatch: the hatch lines will be marked from left to right first and then from right to left, and the others are circular hatch.
[image: ]Bidirectional filling: Fill lines are filled from left to right, then right to left, and the rest are filled in cycles. As shown on the right of figure 3-7.
[image: 1-1][image: 1-2]
Fig.3-7 Left is Unidirectional Hatch filling，Right is Bidirectional Hatch filling

[image: ] Ring Hatch filling: the hatch lines will be marked from outside to inside of the object contour in a circular and skewing manner. 3-8。
[image: ] Ring Hatch: the hatch lines will be marked from outside to inside of the object contour in a circular and skewing manner. As shown on the left of Figure 3-8.
[image: ] Ring filling: filling lines is object outline, from outside to inside cycle offset fill. As shown on the left of Figure 3-8.
[image: ] Optimized bidirectional hatch: It is similar to bidirectional hatch, but the ends of hatch lines will connect. 3-8。
[image: ] Optimized bidirectional hatch: It is similar to bidirectional hatch, but the ends of hatch lines will connect. As shown on the right of Figure 3-8.
[image: ] Bow shaped filling: Similar to a two-way fill, but there are connecting lines between the ends of the fill lines. As shown on the right of Figure 3-8.
[image: 1-3][image: 1-4]
Fig.3-8 Left is Ring Hatch filling, Right is Optimized bidirectional hatch filling
[image: 1-6] Optimization Gong type hatch: similar with Gong, will jump in null place. 3-9：
[image: 1-6] Optimization Gong type hatch: similar with Gong, will jump in null place. As shown in Figure 3-9: 
[image: 1-6] Optimized bow shaped filling: Be similar to bow shaped filling，It will still skip to fill in the blank space of the object. As shown in Figure 3-9:
[image: 1-5]
Fig.3-9 Optimization Gong type hatch Optimized bow shaped filling
Those five types of hatch can be switched over by clicking the button [image: ] with the mouse and can be set or modified conveniently and rapidly according to the required effects.
Angle: the angle between the hatch line and the X axis.  3-10  45 。
Angle: the angle between the hatch line and the X axis. As shown in Figure 3-10, it is a hatching graph when the hatching angle is 45 degrees.
Angle: Refers to the angle between the filling line and the X axis. As shown in Figure 3-10, it is a filling figure when the filling angle is 45 degrees.
[image: 1-7]
Fig. 3-10 Angle is 45 
Line Space: the space between two adjacent hatch lines.
Edge Offset: the distance between hatch lines and the contour when “All Cal” is selected.
Line margin: All fill calculations, Distance between filling line and profile object
[image: 1-1][image: 1-2]
Fig 3-11 Line Space
(Left one line space is 0，Right one line space is 1)
(the left figure is a fill figure with a fill margin of 0, and the right figure is a fill figure with a fill margin of 1)
Follow Edge One Time: adds a contour around the hatch lines after hatch calculation. 
Walk around：After filling calculation, add a contour around the periphery of the filling line
Evenly Distribute Hatch Lines: deals with uneven distribution of hatch lines at the beginning and end of the hatched object. Due to the size of the hatched object, line space, etc., the hatch lines at the beginning and end of the hatched object may be distributed unevenly. To simplify the operation, this function is added so that the hatch lines can be distributed evenly without any resetting of the line space by the user. After it is selected, the software, based on the line space set by the user, will nudge the line space to ensure the even distribution of hatch lines.
Average distrbutio：Solve the problem of uneven distribution of filling lines at the beginning and end of filling objects. Due to the size of the filled object and the setting of the fill line spacing， etc, After filling, there may be uneven distribution of filler lines at the beginning and end of the filled object.To simplify the operation, Without requiring the user to reset the line spacing,It can also achieve the goal of uniform distribution of all filling lines, Add this feature. After selecting this item, The software will automatically adjust the filling line spacing based on the spacing set by the user , To evenly distribute the filling lines
Start Offset: the distance between the first hatch line and the border of the object. 
End Offset : the distance between the last hatch line and the border of the object. 
Linereduction Straight: Refers to the reduction of both ends of the hatch fill line. A positive value indicates reduction and a negative value indicates extension. This function is used when the distances between both ends of the hatch fill line and the contour line are expected to be large during marking.
NumLoops: the times of ring hatch before the aclinicing hatch. The last ring cannot be hatched evenly if only the ring hatch is used, so this function can solve such a problem.
Boundary：Refers to the Before horizontal filling，Advanced ring filling. Due to the function of completely filling with rings, there will be cases where the last ring cannot be filled evenly,So this function is used to solve such problems.
[Note: the line space shall not be too large during text hatching, because a too large line space will cause the hatch filling effect to be invisible.]
Hatch one by one: choose multi object and hatch together, after hatch, still independent
Keep the independence：When multiple objects are filled together after checking, they are still multiple objects
object.Undo Hatch：delet hatching
Delete : Delete the object's fill line and restore the original content
Dissolve Group on Delete: Ungroup when you perform a delete operation.
Dismiss group on wher：
Auto rotate hatch: Refers to after every marking, the hatch line will fill the revolving angle which we setted automatically to marking again. For example, angle is 0, auto rotate angle is 30, the first mark angle is 0, the second is 30, the third is 60, and so on
Auto rotate filling: Check this item and set the rotation angle, then the angle of the filling line will be changed automatically according to the setting after each marking
Automatic rotation a
Multi-figure Operation: Default, Intersection, Union, Difference Set As shown in Figure 3-12, the figure combination can be filled with different patterns.
[image: 1-1][image: 1-2]
[image: 1-3][image: 1-4]
Fig 3-12 The upper left is the default, the upper right is the intersection, the lower left is the union, and the lower right is the difference
[bookmark: _Toc15965][bookmark: _Toc10284][bookmark: _Toc64634074][bookmark: _Toc416973435][bookmark: _Toc414777201]4. Draw Menu
The “Draw Menu” is used for drawing various common shapes, including Point, Line, Curve, Polygon, etc. This menu has a corresponding Toolbar, and all related operations can be achieved through the icons in this Toolbar, as shown in Fig. 4-1. When you select a drawing command or the icon in the Toolbar, the Present Command Toolbar on the top of the workspace will be changed to show some options of the current command.
 [image: C:\Users\loop\Desktop\0714\19.bmp19]                         [image: C:\Users\loop\Desktop\0714\18.bmp18]
        Fig a) “Draw” Menu                       Fig b) “Draw” Toolbar
[image: ]
Fig c) Select command toolbar Select the tools command bar
Fig4-1 “Draw” Operation


 Draw 
 Modify
 View
 Point
 Line
 Curve
 Rectangle
 Circle
 Ellipse
 Polygon
 Text
 Image File
 Vector File
 Time-lapser
 Input Port
 Output Port
 Extended Axis
 Encoder Movement Distance
 Helical Line

[bookmark: _Toc2809][bookmark: _Toc30423][bookmark: _Toc64634075][bookmark: _Toc416973436][bookmark: _Toc414777202]4.1. Point (P)
Drawing a point in the workspace is the simplest drawing operation. By selecting the “Point” command in the menu and clicking the left mouse button at an appropriate position in the workspace, you can draw a point at the position. Also you can draw more points by clicking the left mouse button continuously. After drawing, you can click the right mouse button to stop the point drawing command, and then the last point is displayed as the selected object.
[bookmark: _Toc29548][bookmark: _Toc20224][bookmark: _Toc64634076][bookmark: _Toc14135][bookmark: _Toc416973437][bookmark: _Toc414777203]4.2. Line (L)
To draw a line, the user can select the command “Line” in the Draw Menu or click the icon [image: ], or click and move the left mouse button when the “Line" command is selected.
When the “Line” command is selected, input the coordinates of points directly by clicking the right mouse button, as shown in Fig. 4-2:
[image: ]
Fig. 4-2 “Input Coordinates”

 Input Coordinates
  OK
  Close
[bookmark: _Toc6655][bookmark: _Toc7026][bookmark: _Toc64634077]4.3. Curve (S)
To draw a curve, the user can select the “Curve” command in the Draw Menu or click the icon [image: ].
[image: ]
Fig. 4-3 Curve Drawing
When the “Curve” command is selected, the user can draw curves freely by pressing the left mouse button and moving the mouse.
When the “Curve” command is selected, the user can move the mouse cursor to the beginning node of the curve and press the left mouse button to close the current curve automatically.
[bookmark: _Toc2284][bookmark: _Toc64634078]4.4. Rectangle(R)
To draw a rectangle, the user can select the “Rectangle” command in the Draw Menu or click the icon.
When the “Rectangle” command is selected, the user can press the left mouse button and move it to draw a rectangle.
When the “Rectangle” command is selected, the user can draw a square by pressing the left mouse button and the “Ctrl” key simultaneously and moving the mouse.
When a rectangle is selected, the rectangle properties as shown in Fig. 4-4 will be displayed in the Properties Toolbar.
[image: ]
Fig. 4-4 Rectangle Properties Toolbar
 Object Property Bar
 Location
 Size
 Array
 Apply
 Fillet Degree
 All Edge Fillet
Corner Roundness Degree of fillet: It refers to the roundness of the rectangle’s four corners. If the roundness is 100%, the corner turns into an arc.
All Corners Round: When it is activated, the user can modify the roundness of the four corners by just modifying one of them.
NOTE: Whenever the parameters in the Properties Toolbar are modified, it is a must to click the “Apply” button to effect the modification, which applies to the following operations.
[bookmark: _Toc19176][bookmark: _Toc64634079]4.5. Circle (C)
To draw a circle, the user can select the “Circle” command in the Draw Menu or click the icon[image: ].
When the “Circle” command is selected, the user can press the left mouse button and move the mouse to draw a circle.
When a circle is selected, the circle properties as shown in Fig. 4-5 will be displayed in the Properties Toolbar.
[image: ]
Fig. 4-5 Circle Properties Toolbar
 Object Property Bar
 Location
 Size
 Array
 Apply
 Eadius
 Start Angle
Circle Diameter: the diameter of a circle.
Start Starting Angle: the angle of the starting point of a circle relative to its center.
[bookmark: OLE_LINK12][bookmark: OLE_LINK11][image: 1-2]: It means the current circle is marked clockwise.
[image: 1-3]: It means the current circle is marked anticlockwise.
[bookmark: _Toc64634080][bookmark: _Toc6906][bookmark: _Toc414777207][bookmark: _Toc416973441]4.6. Ellipse (E)
To draw an ellipse, the user can select the “Ellipse” command in the Draw Menu or click the icon[image: ].
[bookmark: OLE_LINK15][bookmark: OLE_LINK16]When the “Ellipse” command is selected, the user can press the left mouse button and move the mouse to draw an ellipse.
When the “Ellipse” command is selected, the users can draw a circle by pressing the left mouse button and the “Ctrl” key simultaneously and moving the mouse. 
[bookmark: OLE_LINK19][bookmark: OLE_LINK20]When an ellipse is selected, the ellipse properties as shown in Fig. 4-6 will be displayed in the Properties Toolbar.
[image: ]
Fig. 4-6 Ellipse Properties Toolbar
 Object Property Bar
 Location
 Size
 Array
 Apply
 Start Angle
 End Angle
Start Starting Angle: the angle of the starting point of an ellipse relative to its center.
End Angle: the angle of the ending point of an ellipse relative to its center.
[bookmark: OLE_LINK10][bookmark: OLE_LINK9][image: 1-2]: It means the current ellipse is marked clockwise.
[image: 1-3]: It means the current ellipse is marked anticlockwise.
[bookmark: _Toc64634081][bookmark: _Toc23587][bookmark: _Toc414777208][bookmark: _Toc416973442]4.7. Polygon (M)
[bookmark: OLE_LINK23]To draw a polygon, the user can select the “Polygon” command in the Draw Menu or click the icon [image: ].
When the “Polygon” command is selected, the user can press the left mouse button and move the mouse to draw a polygon. 
[bookmark: OLE_LINK27][bookmark: OLE_LINK26][bookmark: OLE_LINK13][bookmark: OLE_LINK14]When a polygon is selected, the polygon properties as shown in Fig. 4-7 will be displayed in the Properties Toolbar.
[image: ]
Fig. 4-7 Polygon Properties Toolbar
Edge Num.: It refers to the number of a polygon’s edges with the minimum number of three.
 Object Property Bar
 Location
 Size
 Array
 Apply
 Number of Edges
[bookmark: _Toc1898][bookmark: _Toc12593][bookmark: _Toc64634082][bookmark: _Toc27198][bookmark: _Toc416973443][bookmark: _Toc414777209]4.8. Text (F)
Inputting characters directly in the workspace is supported in SeaCAD, and the fonts include all those supported by the system and many others set in the SeaCAD. To input characters, the user can select the “Text” command in the Draw Menu or click the icon [image: ].
When the “Text” command is selected, the user can create text objects by clicking the left mouse button.
[image: ]
Fig. 4-8 Text Properties Toolbar
 Location
 Size
 Array
 Apply
 TrueTypez  Font  TrueTypez Font
  Auto
  Edge Distance
  Center Distance
1  1mm
  10.000  Height  10.000mm
  Enable Variable Text
If you need to modify the text, you can directly modify it in the text edit box.
SeaCAD supports four types of fonts (TrueType fonts, single line fonts, barcode fonts, bitmap fonts) and other fonts that are installed independently.
After selecting the font type, the font list will list all fonts of the current type accordingly, as shown in Figure 4-9 is a TrueType font list.
[image: C:\Users\loop\Desktop\1.bmp1]
Fig. 4-9 TrueType List
Height: The average height of the font.

 TrueTypez  Font  TrueTypez Font
 FZShuTi 
 FZYaoTi 
  Fangsong
  Black Body
  STCaiyun 
  STFangsong 
  STXingkai
  STHupo
  STKaiti 
  STLiti 
  STSong
  STXihei
  STXinwei
  STZhongsong 
  Regular Script
  Clerical Script
  SimSun
  Microsoft YaHei 
  NSimSun 
  Simyou
[bookmark: _Toc32208][bookmark: _Toc17925][bookmark: _Toc64634083][bookmark: _Toc416973444][bookmark: _Toc414777210]4.8.1. Font Parameters
[image: ]4-10。
After clicking [image: ], the system pops up the dialog box shown in Figure 4-10.
[image: C:\Users\loop\Desktop\0714\20.bmp20]
Fig. 4-10 Font Properties
  Fonts
  Alignment
  Left
  Center
  Right
 Bold
 Italic
  Sorting Direction
  Horizontal
  Vertical
  Enable the Same Width Character
   45.80%     
Character Width   45.80%  Character Height
   0（-89,89）   Character Angle   0 degree (-89,89)
   0mm   Character Spacing   0mm
   0mm   Line Spacing   0mm
  Enable Total Text Width
  20mm   Total Text Width  20mm
    Circle Text
   50  Circle Diameter   50  
   90   Base Angle   90   
  Text Reverse
  Text Invert
  Text Inside the Arc
  90  （1-360）   Angle Range Limit   90  (1-360)
  Apply
  OK
  Close
Alignment: “Left”, “in” and “Right” mean that the current text is aligned to the left/center/right respectively.
Bold: When selected, the current text become bold.
Italic: When selected, the current text become italic
Sorting Arrange direction: Horizontal means Horizontal arrangement, Vertical means vertical arrangement.
Enable the Same Width Character: make all characters keep the same width.
[bookmark: _Toc28775]Char Width: the average width of characters.
Char Angle: the angle of inclination of characters.
Char Space: the distance between characters.
Line Space: the distance between two rows of characters.
Circle Text: [image: 1-3], the text will align according to the user definition circle diameter. As show in figure 4-11. 
Circle Arc Text: Select the [image: ] circle text, the text will align according to the user definition circle diameter. As show in figure 4-11. 
[image: IMG_256]
	Fig. 4-12 Path Circle Text
Circle Diameter Round：diameter of circle text。

Base Reference Angle: the angle benchmark for text alignment. Starting datum with the leftmost angle of the text. As show in figure 4-12.
[image: 1-1][image: 1-2]
Fig. 4-12 Left one base angle is 0，Right one base angle is 90.
fig 4-12 left side is the reference angle = 0, right is the reference angle = 90
Angle Range Limit: When it is selected, the text will be limited in the angle range limit no matter how many characters are input.as shown in Fig. 4-13:
[image: C:\Users\loop\Desktop\3.bmp3]          [image: C:\Users\loop\Desktop\4.bmp4]
Fig. 4-13 Left one is click Angle Range limit，Right one is not On the right, there is no check angle range limit。
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Reverse Inverse text：Reverse the text.as shown in Fig:
[image: 1]
Invert：Invert the text.as shown in Fig:
Text handstand: Arrange text upside down. The following picture:
Text invert
[image: 1]
Text inside the arc：Put the text inside the arc as show in flowing fig.as shown in Fig.4-16:
The text is located inside the arc: Place the text on the inside of the arc, following figure
The text is inside the
[image: ] [image: ]
Fig. 4-16 Text inside the arc The text is located inside the arc

  Path Text
  Base Angle
  Angle Range
  Text Reverse
  Text Top Alignment
  Text Inside the Arc
  OK
  Close
[bookmark: _4.8.3._条形码字体参数][bookmark: _Toc8245][bookmark: _Toc28316][bookmark: _Toc64634084]4.8.2. Barcode Font Parameters
[image: C:\Users\loop\Desktop\0714\21.bmp21]，4-19。
After selecting the barcode font [image: ] in the fonts, click the button barcode [image: ] and the system will pop up a dialog box as shown in Figure 4-19.
[image: C:\Users\loop\Desktop\0714\22.bmp22]
Fig. 4-19 Dialog Box of Barcode Font Parameters
  Barcode
39，；‘0’-‘9’，‘A’-‘Z’，‘$’，‘%’，‘+’，‘-’，‘.’，‘/’；，。
The 39 barcode is a two-way barcode with non-continuous and non-fixed length that represents information by bars and spaces; its character set contains ‘0’-’9’, ’A’-’Z’ spaces, ’$’, ’%’, ’+’, ’-’, ’.’, and ‘/’ ; there are optional check codes, which are automatically added by the system.
  Text
  Display Text
  Black and White Invert
  Blank
  Top
  Left
  Right
  Bottom
  Arial    Font  Arial
  2    Text Height  2mm
  1.5   Text Width  1.5mm
X  0   Text X Offset   0mm
Y  0   Text Y Offset   0mm
   0    Text Spacing   0mm
  24.5    Height   24.5mm
  0.33    Standard Module Height   0.33mm
  Fixed Size
  Scale
  Space
  Bar
  OK
  Close
Show Display Text: determines whether to show a corresponding text for identification under the barcode.
Pen No：Select the pen number for the text, the default is the same as the barcode.
Font: the font of the current text to be displayed.
[bookmark: OLE_LINK36]Text Height: the average height of the text.
Text Width: the average width of the text.
[bookmark: OLE_LINK38][bookmark: OLE_LINK37]Text X Offset: the coordinates of text offset in the direction of X axis.
Text Y Offset: the coordinates of text offset in the direction of Y axis.
Text Space spacing: the space between characters.
[bookmark: _4.8.3.1._一维条形码]4.8.2.1. One-Dimensional Barcode
[bookmark: OLE_LINK24][bookmark: OLE_LINK25]It consists of “bar strip” and “space” arranged one by one. The barcode information is carried by different widths and positions of bar and space, and the information volume is decided by the width and the precision of barcode. The wider the barcode is, the more bars and spaces are included, and the more information is carried. This kind of barcode technology can store information in only one direction through permutation and combination of bars and the spaces, so it is called one-dimensional barcode. Fig. 4-20 shows the parameter setting in the window when a one-dimensional barcode is selected.
[image: C:\Users\loop\Desktop\0714\23.bmp23]
Fig. 4-20 One-dimensional Barcode Parameters
  Black and white Invert
  Blank
  Top
  Left
  Right
  Bottom
  16.170    Barcode Height  16.170mm
  4.53883   Standard Module Width  4.53883mm
  Scale
  Bar
  Space
Black and White Invert Reversa: determines whether to invert the marking. This function is used for some materials which are light-colored after marking.
Quiet: It refers to the limited area where the reflectivity at the outer ends or middle of the barcode is the same as that of the space. The actual width of the Quiet area is a scale of the narrow bar width multiplied by the Quiet area.
Blank：When the barcode is reversed, you can specify the size of the blank area around the barcode.
Bar Barcode Height: the height of the barcode.
[bookmark: OLE_LINK42][bookmark: OLE_LINK41]Standard Width: It refers to the width of the narrowest bar, i.e. the width of the unit bar. Commonly a one-dimensional barcode consists of bars and spaces with four types of width respectively, and 1, 2, 3 and 4 refer to 1, 2, 3 and 4 times the width of the unit bar as per the width size of bars and spaces. The width of the narrow bar means the width of one unit bar.
Refers to the width of the narrowest strip module, that is, the width of the reference strip module
[bookmark: OLE_LINK44][bookmark: OLE_LINK43][bookmark: OLE_LINK46][bookmark: OLE_LINK45]The actual width of Bar 2 is a scale of the narrow bar width multiplied by the width of Bar 2, and the method applies for Bar 3 and 4.
The actual width of Space 1 is a scale of the narrow bar width multiplied by the width of Space 1, and the method applies for Space 2, 3 and 4.
Blank：A limited area with the same reflectivity as the space on the outside or in the middle of the left and right ends of the barcode，The actual width of the blank area is equal to the width of the narrow strip module multiplied by the proportion of the blank.
4.8.2.2. Two-Dimensional Barcode

4.8.2.2.1. PDF417 Barcode
PDF is the abbreviation of the Portable Data File. Figure 4-21 is the demonstration of PDF417 Barcode. 
PDF is the acronym of the three words "Portable Data File", meaning "Portable Data File". Figure 4-21 is the demonstration of PDF417 Barcode. 
Bar code Height: the height of the barcode
Narrow width: This refers to the width of the unit bar.
Module width: Refers to the width of the narrowest bar module.
Level Error correction：the Error-Checking Level of PDF417 barcode, from 0 to 8.
Lines and Columns: the lines and Columns of PDF417 barcode.
[image: ]
Fig. 4-21 PDF417 Barcode
4.8.2.2.2. DataMatrix Barcode
DataMatrix is a kind of two-dimensional barcode based on Matrix, as shown in Fig. 4-22:
Data Matrix has various fixed size, and users can choose what they want have. If the smallest size is chosen [image: ]，the system will automatically select the smallest frame to fit the all text users
Data Matrix has various fixed size, and users can choose what they want have. If the smallest size is chosen ，the system will automatically select the smallest frame to fit the all text users
[image: ]
Fig. 4-22 DataMatrix Barcode
4.8.2.2.3. QR-Code
QR-Code Barcode is a kind of two-dimensional barcode and its character set includes all ASCII values, as shown in Fig. 4-23:
[image: ] [image: C:\Users\loop\Desktop\0714\24.bmp24]
Fig. 4-23 QR-Code Barcode and QR code parameter setting
  Barcode
  Text
  Display Text
  0  Pen Number  0
  Arial  Font  Arial
 3  Text Height  3mm
 1.5  Text Width  1.5mm
X  0   Text X Offset   0mm
Y  0   Text Y Offset   0mm
   0    Text Spacing   0mm
  Custom Display Text
（# ? % /）  (#Character ?Delete %Validation /Newline)
  Dot Mode
  Circle Mode
  Rectangle Mode
50%  Small Graph Width Accounts for 50%
  Black and White Invert
  Blank
  Top
  Left
  Right
  Bottom
  0.33    Standard Module Width   0.33mm
  Fixed Size
  Scale
  Bar
  Space
      Matrix   Default
   L  Error Correction Level  L
  Center Blank
：15%  Blank Scale: 15%
  OK
  Close
：。
Display Text: The function under the display text is the same as the text function of the barcode properties.
Custom display text：User can use commands to display the text you want to display. #- represents the character that shows the current position,? - represents the character that deletes the current position, %- represents the position number of the character that displays the current position, and -/ is a line-up display character string. For example:
[image: ]   [image: ]
[image: ]
  Barcode
  Custom Display Text
（# ? % /）  (#Character ?Delete %Validation /Newline)
Dot point Mode, Circle Round Mode, and Rectangle Mode: Select the mode that makes up the two-dimensional code. The examples are as follows (from left to right, dot point mode, circle Round mode, rectangle mode):
[image: 1]
The proportion of graphics width：Set the size of the element which formed two-dimensional code. The adjustment range is from 1 to 100. It is valid only for the circle mode and rectangle mode.
Fixed size：Set the size of the two-dimensional code.
Center blank：An area will be vacated in the center area of the QR code , which will be used to place company LOGO, pictures, etc.

[bookmark: _Toc18017][bookmark: _Toc19543][bookmark: _Toc64634085][bookmark: _Toc414777213][bookmark: _Toc416973447]4.8.3. Variable Text
[bookmark: OLE_LINK29][bookmark: OLE_LINK28]The Enable Variable Text will be available after [image: ] is selected, and the variable text properties as shown in Fig. 4-24 will be displayed by the system. The “Variable Text” means that a text can be modified dynamically based on the rules given by the user during marking.
The Enable Variable Text will be available after the [image: ]Enable Variable Text is selected, and the variable text properties as shown in Fig. 4-24 will be displayed by the system. The “Variable Text” means that a text can be modified dynamically based on the rules given by the user during marking.
[image: ]
Fig. 4-24 Variable Text Properties

  Auto
  Edge Distance
  Center Distance
1   1mm
  Enable Variable Text
Distance Control: the distance between characters as per the current character arrangement pattern.     
Auto: Automatically sets the distance between characters.
[bookmark: OLE_LINK49][bookmark: OLE_LINK50]Spacing Margin: It refers to the distance from the right boundary of left character to the left boundary of right character.as shown in Fig. 4-25:
[image: 1-1]
Fig.4-25 Spacing Margin
   Character Spacing 
Center Distance: It refers to the distance from the center of left character to the center of right character.as shown in Fig. 4-26:
Center Distance: The calculation of character spacing refers to the distance between the left character center and the right character center. as shown in Fig. 4-26:
[image: ]
  Character Center Distance
Fig.4-26 Center Distance
The user may add various variable text elements as required and sequence the text elements. After the “Add Text Element” is selected, the dialog box as shown in Fig. 4-27 will pop out.
[image: C:\Users\loop\Desktop\0714\25.bmp25]
Fig. 4-27 Text Element Dialog Box
  Text Elements
  Element Type
  Fixed Text
  Serial Number
  Date
  Time 
  TCP/IP Communication 
  Serial Communication
SQL  SQL Database 
  File
  Keyboard
TXT   Real-time TXT Text
Excel  Real-time Excel Text
  Leading Zero Before Disuse
  Text 
  Text Type
  Text
  Newline Character
  Username
[bookmark: OLE_LINK32][bookmark: OLE_LINK33]Fixed Text: It refers to the invariable element in the text during marking.
[bookmark: OLE_LINK51]Serial Number: It refers to the element changing with the fixed increment during marking.
[bookmark: OLE_LINK66][bookmark: OLE_LINK65][bookmark: OLE_LINK52][bookmark: OLE_LINK53]Date Code: The system will automatically read date information from the computer during marking.
Time: The system will automatically read time information from the computer during marking.
[bookmark: OLE_LINK58][bookmark: OLE_LINK59]TCP/IP Communication: The system will read the text to be marked through the network during marking.
Network Communication: During the processing, the system reads the elements of the text to be processed through the network
[bookmark: OLE_LINK61][bookmark: OLE_LINK60]Serial Communication: The system will read the text to be marked through the serial port during marking.
[bookmark: OLE_LINK39][bookmark: OLE_LINK40]SQL Database: The system will automatically read the text to be marked from the connected database during marking.
File: Text to be processed are read directly from the "TXT" "EXCEL" file.
Keyboard: The elements of the text to be processed are entered by the user from the keyboard during processing.
4.8.4.1. Fixed Text Element
It refers to the invariable element during marking.
[image: C:\Users\loop\Desktop\0714\25.bmp25]
Fig.4-28 Fixed Text Element

  Text Elements
  Element Type
  Fixed Text
  Serial Number
  Date
  Time 
  TCP/IP Communication 
  Serial Communication
SQL  SQL Database 
  File
  Keyboard
TXT   Real-time TXT Text
Excel  Real-time Excel Text
  Leading Zero Before Disuse
  Text 
  Text Type
  Text
  Newline Character
  Username
Newline character: Applied to the variable text function to solve the problem of multiple lines that require branch marking. When applied, a new line character is added between the two texts, and the software automatically branches the text according to the position of the newline character. If multiple texts need to be split into multiple lines, simply add a line break after the text to be split
Username: When this option is selected, the system automatically replaces the current user name using SeaCAD with a fixed text.
4.8.4.2. Serial Number Element
The serial number element is a text element which changes with the fixed increment during marking.
When the Serial Number is selected, the serial number parameter definition will automatically be displayed in the text element dialog box, as shown in Fig. 4-29.
[image: C:\Users\loop\Desktop\0714\26.bmp26]
Fig.4-29 Serial Number Element
  Text 
  Start Serial Number
  Current Serial Number
  Final Serial Number
  Serial Number Increment
   Number of Every Marking
  Mode 
  Reset
  Integral Point Reset
  Non-Circular Marking 
  Number of Current Marking
  Decimal System
  Setting
  Filter the Following Serial Number 
  OK 
  Close
Start SN: the first serial number to be marked at the moment.
Current SN: the serial number to be marked at present.
Limit Final SN: When it comes to the marking of limit serial number, the system will return to the start serial number automatically.
Increment Serial: It refers to the increment of the current serial number. When set as a negative value, the serial number will decrease progressively.
[bookmark: OLE_LINK63][bookmark: OLE_LINK62]When the increment of the current serial number is 1, and the start serial number is 0000, each number will be added with 1 based on its previous number, for example, 0000, 0001, 0002, 0003 … 9997, 9998, 9999. When it comes to 9999, the system will return to 0000 automatically.
When the increment of the current serial number is 5, and the start serial number is 0000, the serial numbers are: 0000, 0005, 0010, 0015, 0020, 0025…..and so forth.
Marks Per: the number of serial numbers to be marked required for the change of serial number per time.
Each Marks：It means that the serial number will not be changed until the specified number is processed for each serial number. Then, after machining to the specified number, the serial number is changed again to cycle.
Current Marks.: The marking times of the current serial number. When it equals to Marks Per, it will turn to 0 automatically.
Current Marks.: It means that the serial number will not be changed until the specified number is processed for each serial number。Then, after machining to the specified number, the serial number is changed again to cycle.
Mode: the carry mode of the current serial number.
[image: ]: The system will filter out serial numbers whose certain digit is a particular value after it is selected. The [image: 9a48dcce5c4f4006ae7b9fd46337b017] means that the serial numbers with 4 as the tail number will be filtered out, and the * can be numbers with any digits.
Reset: You can customize the reset time or reset every point. Every day this time, the serial number of the mark changes to the start sequence number.
[image: ]：Stop the marking task after you finish the Specified sequence number。
4.8.4.3. Date Code
Date Code element: The system will automatically read date information from the computer during marking.
When the Date Code element is selected, the date parameter definition will be displayed in the text element dialog box automatically, as shown in Fig. 4-22.
[image: ]
Fig. 4-22 Data Code element Parameter Definition
  Text 
  Custom
-2019  Year-2019 
-19  Year-19 
-9  Year-9  
-12  Month-12 
-5  Date-5 
-339  Day-339 
-04  Day of Week-04 
-4  Day of Week-4 
-49  Week of Year-49
  Date Offset 
  Per Annum
  OK 
  Close
Year-2020: takes the year indicated by the current computer clock as the corresponding text with four characters.
Year-20: takes the year indicated by the current computer clock as the corresponding text with two characters: only the latter two digits are taken.
Month-02: takes the month indicated by the current computer clock as the corresponding text with two characters.
Day-07: takes the date of each month indicated by the current computer clock as the corresponding text with two characters.
Day-038: takes the number of days from January 1 to the date indicated by the current computer clock as the corresponding text with three characters. (001 represents January 1, 002 represents January 2, and so on).
Day of Week-05: takes the day of week indicated by the current computer clock as the corresponding text with two characters.
Week of Year-5: takes the week of year of the date indicated by the current computer clock as the corresponding text with two characters (take the period from January 1 to the first Saturday as the first week).
Date Offset: When the system reads the date indicated by the computer clock, it is necessary to add the set offset-date to obtain the marking date. This function is mainly used for the marking of workpieces with production date and shelf life in food industry and the like.
：。
Custom: Define the display content of the year by yourself.

4.8.4.4. Time Element 
Time Element is system will automatically read time information from the computer during marking.
[bookmark: OLE_LINK68][bookmark: OLE_LINK67]When the Time Element is selected, the time parameter definition will automatically be displayed in the text element dialog box, as shown in Fig. 4-23.
[image: ]
Fig. 4-23 Definition Time Parameter 
  Text
-24  Hour-24
-12  Hour-12
  Minute
  Second
  Time Section
Hour-24: takes the time in hour indicated by the current computer clock as the corresponding text in the 24-hour time system.
Hour-12: takes the time in hour indicated by the current computer clock as the corresponding text in the 12-hour time system.
[bookmark: OLE_LINK72][bookmark: OLE_LINK71][bookmark: OLE_LINK70][bookmark: OLE_LINK69]Minute: takes the time in minute indicated by the current computer clock as the corresponding text.
Second: takes the time in second indicated by the current computer clock as the corresponding text.
Time section Period: 24 hours of one day are divided into 24 time sections, and the user can define a text for each time section. This function is mainly used for the marking of workpieces requiring the shift information.
4.8.4.5. TCP/IP Network communication
When the operation is taking place, the system will pick up the text from the network. 
The network communication element is the element that the system automatically reads the text from the network through the computer network interface during the processing
Notice: The network interface in here is the network interface uses in TCP/IP agreement. When the user selected the “TCP/IP communication”, the parameter defines will display automatically in the dialog box, see the figure 4-24: 
  [image: C:\Users\loop\Desktop\0714\27.bmp27]
Fig.4-24 TCP/IP Network communication elements
  Text Elements
  Element Type
  Fixed Text
  Serial Number
  Date
  Time 
  TCP/IP Communication 
  Serial Communication
SQL  SQL Database 
  File
  Keyboard
TXT   Real-time TXT Text
Excel  Real-time Excel Text
  Leading Zero Before Disuse
  Text
IP  IP Address
  Port Number
  Marking
  Timeout Setting
  Connect Timeout
  Receive Timeout
  OK 
  Close
IP Address: select the IP address which from reads the data
Port The: select the port the TCP/IP communication used
Command: When the system processes to this text object, the system through the network interface to transmit this order character string to a computer assigned the IP address, request the computer sends the character string needs to process at present, the system will not return until the computer replied, after the response of the computer, the system will process the returns text automatically.
Unicode: After choosing this option, the system to the computer transmission which and the read character is the Unicode form, otherwise is the ASCII form. 
Timeout setting: You can set the timeout period for connecting the specified IP address and receiving data.





4.8.4.6. Serial communication
When the operation is taking place, the system will pick up the text from the serial port. When the user selected the “Serial communication”, the parameter defines will display automatically in the dialog box, see the figure 4-25. 
The serial communication element is the element that the system automatically reads the text from the peripheral device through the computer serial port during the processing，When the user selects the serial communication element, the parameter definition of the serial communication element will be automatically displayed in the text element dialog box。As shown in Figure 4-25.
[image: C:\Users\loop\Desktop\0714\28.bmp28]
Fig.4-25 Serial communication

  Text Elements
  Element Type
  Fixed Text
  Serial Number
  Date
  Time 
  TCP/IP Communication 
  Serial Communication
SQL  SQL Database 
  File
  Keyboard
  Text
  Port Number
  Baud Rate
  Data Bits
  Stop Bits
  Parity
  Marking Document
  Display Part of Data
  Add Newline
12（）  1st to 2nd (From Right)
  OK 
  Close
Port: the port which computer and peripheral equipment connection used
Baud Rate: Baud Rate which the serial communication used
Data Bits: Data Bits which the serial communication used
Stop Bits: the digits of Stop Bits of which the serial communication used
Parity: select the digits of Parity which the serial communication used
Command: When the system processes to this text object, the system through the serial port to transmit this order character string to a peripheral equipment, request the peripheral equipment sends the character string needs to process at present, the system will not return until the peripheral equip                                                                                                                                                         ment replied, after the response of the peripheral equipment, the system will process the returns text automatically 
Command: When the system processes this text object, the system will send this command string to the external device through the current serial port，Request the external device to send the current string to be processed,The system will wait for the external device to answer before returning,After the external device answers, the system will automatically process the returned text.
Display part of data: check to show characters between specified bits
Show only partial data
4.8.4.7. File element
TXT: When select TXT file, a dialog box as Figure 4-26 shows will be displayed to ask for the file’s name and the current text’s line number. 
TXT: When TXT is selected, the content shown in Figure 4-26 will be displayed. The user is required to set the line number of the associated file and the current text to be processed
Auto reset: If checked, the line number will change to 0 automatically when reach the last line. The next mark will start from the first line again 
Automatic reset: When the processing reaches the end of the text file, the line number is reset to 0, and the processing starts again from the first line.
Read all lines Read the entire file: When processes to the text document direct read entire Document.
[image: C:\Users\loop\Desktop\0714\29.bmp29]
Fig.4-26 TXT

  Text
  File Name
  Line Number
  Increment
  Auto Reset
  Read the Entire File at a Time
EXCEL：We have to appoint the file name, Field name, Line number to tell the software which cell in the excel table will be mark 
EXCEL：When the excel file system is selected, the content shown in Figure 4-27 will be displayed. The user is required to set the file name, field name and line number of the current text to be processed.
File name: The text string of the first row in the datasheet1. This parameter indicates which column will be marked.
Field name: The text of the first row of all columns of form 1 in the excel file table. During processing, the system will automatically take out the text to be processed from the corresponding column.
[image: C:\Users\loop\Desktop\0714\30.bmp30]
Fig. 4-27 EXCEL

  Text
  File Name
  Line Number
  Increment
  Field Name
  Auto Reset

4.8.4.8. Keyboard
The keyboard element is the text which must process from the keyboard entry by the user, when select the keyboard element, a dialog box as Figure 4-47 shows will be displayed to ask for the user set the keyboard element parameter. Tips In the process of processing, when the system encounters the text of keyboard variables, it will pop up the content in the input dialog box, requiring the user to enter the text to be processed, at this time, the user directly enters the text to be processed manually.
[image: C:\Users\loop\Desktop\0714\31.bmp31]
Fig.4-28 Keyboard
  Text
  Tip
  Please enter the text to be processed
  Fixed Character Count
  Set Pen Parameters
  Input Port
Fixed char count Number: user must input string with digit equals to this count.
Set Pen Param: When selected, we can get power, speed, frequency from the keyboard entry, only through setting pen*. power, pen*.speed or pen*.freq. The “*” is number of pen.
Set Pen Param: The keyboard can be used to directly read the processing parameters of speed, power and frequency, Set pen 0.power to indicate the power of pen 0, pen 1.speed to indicate the speed of pen 1, pen 2.freq to indicate the frequency of pen 2, and set according to this rule.
	The keyboard element function uses frequently in this kind of situation when the processing needs the real-time input to the processing content. If the customer present need processes one batch of work pieces, on each work piece is printed with a bar code, when processing needs the user with the bar code scanning gun real-time scans the work piece to read the content on the bar code, then with laser to mark to the work piece assigns in the position, at this time can use the keyboard element function. At the processing time system springs like the figure 4-30 shows the dialog box, the operator with the bar code scanning gun scanning bar code work piece on, the bar code scanning gun inputs the read content to the dialog box inside and closes it automatically, then the system will start to process the content read a moment ago automatically . 
4.8.4.9. Advance Function
After the “Advance” function is selected, the dialog box as shown in Fig. 4-29 will pop out.
After selecting advanced functions, the system will pop up a dialog box as shown in Figure 4-29.
[image: ]
Fig.4-29 Advance Function

  Advance
  
Text Object that Enables Split Strings to Modify the Specified Name  
  Mark Self
 10.000mm  Enable Fixed Text Width  10.000mm
  Add
  Delete
  Modify 
  OK 
  Close
[bookmark: OLE_LINK74][bookmark: OLE_LINK73]Mark Self yourself: In certain situations, when the user needs to split the variable text and then mark them in different positions, and also needs to mark the variable text, this function is applicable. It is conducted by setting the parameters for character splitting and selecting “Mark Self”. During marking, besides the split character, all input variable texts will be marked in corresponding positions.
：，。
Enable Fixed Text Width: Set the fixed length of the text, and the length is fixed no matter how much the content.
Select “Enable Split String to Change Other Text Entity”, and click “Add” button to get the dialog box as shown in Fig. 4-30.
Select “Enable Split String to modify text object the”, and click “Add” button to get the dialog box as shown in Fig. 4-30.
     [image: ]
Fig.4-30 Advance Function

  Parameters
  Location of the First Character in String
  
Total Number of Characters Extracted From the String
  
The Name of the Text Object that You Want to Modify the Character Content  
  OK 
  Close
Index of the First Character in String: the order of the first character in the character string of variable TEXT1 text.
The position of the first character in the string: The starting character in text1 text is the number of characters in the string of variable text.
The Number of Characters to Extract from String: extracts a certain number of characters starting from the first character in the character string of variable text.
The total number of characters extracted: Extract several characters from the string of variable text from the first character set.
The Name of Text Entity Which You Want to Change: When it is selected, it is necessary to input the name of a fixed text for the character to be split and read.
The text object name for which you want to: Enter the name of the fixed text that you want to modify for the characters read by the partition.
Add Char Mode: when it is selected, the split and read character will be added to the position following the fixed text. 
For example:
1. Create a new variable text (take a variable serial number text as an example)

2. Click “Advance” in the Variable Text Properties Toolbar, and select “Enable Split String to Change Other Text Entity”, as shown in the following figure:
[image: ]
Fig.4-31
  Advance
  
Text Object that Enables Split Strings to Modify the Specified Name  
  Mark Self
10.000mm  Enable Fixed Text Width 10.000mm
  Add
  Delete
  Modify 
  OK 
  Close
3. When “Add” is clicked, the following dialog box will pop out (it means that two characters starting from the first character in the variable text are extracted to replace the content in the fixed text entity with an indicated name) [image: ]
Fig.4-32

  Parameters
  Location of the First Character in String
  
Total Number of Characters Extracted From the String
  
The Name of the Text Object that You Want to Modify the Character Content  
  OK 
  Close
4. After clicking OK, draw another fixed text entity, and modify its name as per the name set as above.
After confirmation, draw a fixed text object, and change the name of the text object to the name set by the above rule
[bookmark: _Toc26518][bookmark: _Toc24172][bookmark: _Toc64634086][bookmark: _Toc414777214][bookmark: _Toc416973448]4.9. Bitmap Draw Picture file
[bookmark: _Toc64634087][bookmark: _Toc27485][bookmark: _Toc25007]4.9.1.  Input Bitmap
To add a bitmap, the user can select the “Bitmap” command in the Draw Menu or click the icon [image: ].
[image: ]
Fig. 4-33 Bitmap Inputting Window

The system will pop up the input dialog box as shown in Figure 4-33 and ask the user to select the bitmap to be input. The currently supported bitmap formats are: Bmp; Jpeg, jpg; Gif; Png; Tiff; Tif; Emf. The system will automatically display the picure of the current file in the preview box, and will also put the center of the current picture on the origin of the coordinates.
After entering the bitmap, the property toolbar displays the bitmap parameters as shown in Figure 4-34.
 [image: ]
Fig.4-34 Bitmap parameters

[bookmark: _Toc64634088]4.9.2. Invert Reversal
Invert: takes the opposite color value for each point of the current image, as shown in Fig. 4-35.
Reversal: The color value of each point in the current picture is reversed, and the formula adopted is PX new = 255 – PX old, as shown in Figure 4-35.
[image: ]
Fig. 4-35 Inverted Reversal Image
[bookmark: _Toc64634089]4.9.3. Grey Scal GrayScal
changes a color image into a 256-level grey scale image, as shown in Fig. 4-36. In the state of gray-scale image, the contrast and brightness of the image can be adjusted to achieve better marking effect.
[image: ]
Fig. 4-36 Grey Scale Marking Image gray processing example
[bookmark: _Toc64634090]4.9.4. Fixed DPI
It is similar to the resolution of images. When the DPI value of the original bitmap is not fixed or unclear, the fixed DPI value can be set by means of “Fixed DPI”. The higher the DPI level is, the closer the dots gather, the higher the photo precision is and the longer the marking time is.
The concept of DPI is the number of pixels per inch, one inch equals 25.4mm. When the DPI value is higher, the image printing is clearer and the processing time is longer. Otherwise, the more blurred, the processing time is shorter. You can use the default DPI value without fixing the DPI.
[bookmark: _Toc64634091]4.9.5. Dither Outlets
Dither: This effect is similar to the “Halftone Pattern” function in Adobe PhotoShop. It uses a black-and-white image to simulate a grey scale image and achieves different grey scale effects by adjusting the density of points based on black and white colors, as shown in Fig. 4-37.
Outlets: Dot representation is similar to the "halftone pattern" function in Adobe Photoshop. Black and white dichroic images are used to simulate gray-scale images, and black and white dichroic images are used to simulate different gray-scale effects by adjusting the density of points, as shown in figure 4-37.
[image: ]    [image: ]
Fig.4-37 Dither Outlets
[bookmark: _Toc64634092]4.9.6. Bidirectional Scan Two-way scanning
The scanning is bidirectional during the marking of bitmaps. 。
The scanning is bidirectional during the marking of bitmaps. This method can improve a certain marking speed.

[bookmark: _Toc64634093]4.9.7.   Dotting Time
：。，。
Dotting Time: The time it takes for the laser to dot each pixel. This value can be modified to adjust the bitmap marking speed under the dotting mode.
[bookmark: _Toc64634094]4.9.8.   Dot Power Mapping
。，，，；，。，。4-38。
Different pixels map different dotting powers. The maximum value in the interface is to set the maximum power. Click the maximum value and then press reset to generate a new mapping table; similarly, you can set the minimum value or set a specific value. After setting, press the reset button to regenerate the mapping table. The effect is shown in Figure 4-38.
Different pixel mapping different power，
[image: ]
4-38 
Figure 4-38 Dot Power Mapping 

  Power Mapping
  Grey Scale
%  Power% 
 OK 
  Cancel 
  Generate 
  Maximum Value 
  Minimum Value 
  Modify
[bookmark: _Toc64634095]4.9.9. Expand Parameter
Expand Parameter: Figure 4-39.
Y Scan: The scan will run along Y axis line by line.
Y direction scanning: Set y-scan, the printing direction will be changed to y-scan.
Scan line Increment: This item indicates whether to scan line by line or skip some lines. This function may quicken the marking speed when in low precision marking requirement.
Bitmap scan increment: When there are many image pixels or large image area, printing is time-consuming. You can scan additional lines, skip several lines for printing, but the printing effect will be reduced.
Disable Mark Low Gray Point: This item indicates that every point is marked or only marking bigger gray points. This function may quicken the marking speed when in low precision marking requirement.
A point below the pixel value: Set the pixel point below which pixels will not be marked.
Line feed malposition: The point isn’t aligned between two adjacent rows, but the point is aligned with the position which is the middle of two points in the previous line, to avoid the trace of marking.
Point interlaced dislocation: In even rows, the first pixel is removed, and each pixel in the remaining rows moves forward one pixel in turn.
Optimize Mode: calculate the marking speed according to the DPI and frequency to optimize marking speed and result.
：。
Acceleration Distance and Deceleration Distance: Control the marking and its movement acceleration parameters.
：X，Y。
Overall Offset and Bidirectional Offset: Control the amount of movement in the X and Y directions of the marking images. 
Overall migration and Bi-directional: Control the amount of movement in the X and Y directions of the marking images. 
[image: ]
Fig.4-39 Expand Parameter
  Bitmap
Y  Y Direction Scanning
  Bitmap Scanning Line Increment
  Do Not Mark Points Below the Pixel Value
  Point Interlacing Dislocation
  Optimization Mode
  0  Acceleration Distance  0mm 
  0  Deceleration Distance  0mm
  0  Overall Offset  0mm 
  0  Bidirectional Offset  0mm
  OK 
  Cancel

[bookmark: _Toc64634096][bookmark: _Toc414777215][bookmark: _Toc416973449]4.10. Draw Vector File
To input a vector file, the user can select the “Vector File” command in the Draw Menu or click the icon [image: ].
The bitmap formats supported by the current system include AI, PLT and DXF. The Fig. 4-40 shows the result of vector image import.
[image: ]
Fig. 4-40 Vector Image Import
[bookmark: _Toc18182][bookmark: _Toc29844][bookmark: _Toc64634097]4.11. Time-lapser Draw delay
To input the control object of delayer, the user can select the “Delayer” command in the Draw Menu or click the icon.
If you want to enter a delayer control object, Choose the time delay command from the draw menu or click the icon.
When the “Delayer” is selected, the delayer property as shown in Fig. 4-41 will be displayed in the Properties Toolbar.
[image: ]
Fig. 4-41 Delayer Property
  10    Waiting Time  10 ms
Waiting time: When the marking comes to the current delayer, the system will wait for a scheduled period and then continue to operate.
[bookmark: _Toc19019][bookmark: _Toc26494][bookmark: _Toc64634098][bookmark: _Toc416973451]4.12. Draw Input Port
To input the control object of input port, the user can select the “Input Port” command in the Draw Menu or click the icon [image: ].
After the “Input Port” is selected, the input port properties as shown in Fig. 4-42 will be displayed in the Properties Toolbar.
[image: ]
4-42 
Figure 4-42 Input Port Parameters

I/O  I/O Control Condition
  Prompting Message
  Enable
I/O Control Condition: When the marking comes to the current input port, the system will read the input port and compare the read value with the I/O Control Condition; if the two equal, the system will proceed to the following ports, and otherwise it will read the port again.
Prompt Message: It is given by the system when it reads the port repeatedly and waits for the matching between the port value and the I/O Control Condition.
[bookmark: _Toc29295][bookmark: _Toc12455][bookmark: _Toc64634099][bookmark: _Toc416973452][bookmark: _Toc414777218]4.13. Draw Output Port
To draw the control object of output port, the user can select the "Output Port” command in the Draw Menu or click the icon [image: ].
[bookmark: OLE_LINK88][bookmark: OLE_LINK89]After the “Output Port” is selected, the output port property as shown in Fig. 4-43 will be displayed in the Properties Toolbar.
[image: ]
Fig. 4-43 Output Port Parameters
  Set Output Port
[bookmark: OLE_LINK90][image: ]The system will provide the port with high-level voltage when the marking comes to the current output port.
[image: ]The system will provide the port with low-level voltage when the marking comes to the current output port.
[image: ] The system will provide the port with a level signal and keep it.
[image: ] The system will provide the port with a pulse signal and it can set the pulse width.
[bookmark: _Toc64634100]4.14. External Axis Encoder moving distance（Lite version does not support this feature）
“”，“”， 4-49 ：
Select the “Extended Axis” command in the draw menu, and the “Extended Axis” object will be displayed in the object list, as shown in Figure 4-49 below:
[image: ]
Fig.4-49 External Axis Encoder moving distance
1  Extended Axis 1
  Relative Location
  Whether to Return to Zero
  Move 
  Millimeter
  Pulse
  Degree
  Extended Axis Configuration



Correct axis origin: The current expansion axis go zero and reset coordinates. The following example explains how to use this module.
Extended axis correction Zero: Check this to return the motor to zero
Relative position: It means the origin is used as the reference when the motor moves.
Relative position: Indicates whether the motor moves based on the origin or relative position.
Number of moving pulses: how many pulses are sent to the motor, and the number of pulses indicates the motor movement distance.
Unit type：unit of motor movement distance
[bookmark: _Toc64634101][bookmark: _Toc414777220][bookmark: _Toc416973454]4.15. Encoder Movement Distance
When the “Encoder Movement Distance” command in the Draw Menu is selected, the “Encoder Movement Distance” will be displayed in the Object List as shown in Fig. 4-50:
[image: ]
Fig. 4-50 Dialog Box of Encoder Movement Distance
 1000.000  
Encoder Movement Distance 1000.000 mm
 “Encoder Movement Distance” is mainly used for detecting the movement distance of flying objects during the process of mark on the fly.
[bookmark: _Toc64634102][bookmark: _Toc416973455][bookmark: _Toc414777221]4.16. Helical Line
The helical line can be added to objects outside the frame and the following parameters can be set: equal pitch, unequal pitch and helical line setting from inward to outward or from outward to inward, as well as the minimum radius, the minimum and maximum pitches of helical line, variation of pitch, number of rings of outer and inner boundaries, etc., as shown in Fig. 4-51:
Helix can be added to the outer frame object, and parameters such as equal pitch, unequal pitch, helix setting from inside to outside, from outside to inside, and minimum radius, minimum helix pitch, maximum helix pitch, pitch variation, outer boundary ring number, inner boundary ring number can be selected
[image: ]
Fig. 4-51 Helical Line Setting Dialog Box
  Helix  
  OK 
  Close 
  Pen Number
  3   Minimum Radius  3 mm
  0.5   Minimum Helix Pitch  0.5mm
  0.5   Maximum Helix Pitch  0.5mm
   0.1  Pitch Variation  0.1mm  
  Number of Outer Boundary Rings 
  Number of Inner Boundary Rings 
  Enabling Cycle  
  Number of Cycles

[bookmark: _Toc14462][bookmark: _Toc20223][bookmark: _Toc64634103][bookmark: _Toc10209][bookmark: _Toc17034][bookmark: _Toc416973453][bookmark: _Toc414777219]4.17. Graph Selection Graphics picking
The icon [image: ] on the top of the Draw Toolbar is used for graph selection.
The depressed state of the icon indicates that the command is selected at that time if no other command is selected, and you can select an object by clicking objects in the workspace with the mouse. The software has the “Auto-snap” function, and you can select an object by clicking the left mouse button if the mouse cursor is near a curve in the workspace.
You can also press the left mouse button and move the mouse to select an object, and there will be a dashed frame in the area where the mouse moves through. Objects wholly included in the dashed frame will be selected. 
When the “Select” command is selected, the Select Toolbar will be displayed, and you can realize some particular operations, as shown in Fig. 4-44:
[image: ]
Fig. 4-44 Select Toolbar
[image: ] It means that the current object is locked and you can’t conduct any editing operations on it. Some lock-like icons will appear around the object at that time.
[image: ] It means unlocking locked object selected currently.
[image: ] It means unlocking all the locked objects.
[image: ] It means placing the selected object to the origin.
[image: ] It means selecting objects by the pen number. The dialog box as shown in Fig. 4-45 will be displayed after the command is selected.
[image: ]
Fig. 4-45 Dialog Box of Selection by Pen Number
  Select Objects by Pen Number
  Pen Number 
  Colors
  OK 
  Cancel
[image: 1-1]Indicates that the current selection object will be mirrored horizontally。As shown in figure 4-46 below:
[image: 1-2][image: 1-3]
Fig.4-46 Mirrored horizontally




[image: 1-1]Indicates that the current selection is vertically mirrored：As shown in figure 4-47:
[image: 1-2][image: 1-3]
Fig.4-47 Vertically mirrored
[image: 1-1]Show or hide the current figure’s marking path ：As shown in Figure 4-48:
[image: 1-2][image: 1-3]
FIg.4-48 Figure’s marking path
[bookmark: _Toc64634104][bookmark: _Toc416973456]5. Modify Menu 
Commands in Modify Menu will take easy operations on selected objects, such as transformation, Plastic, Curve Editing, Aligning, etc. (Fig. 5-1)
Commands in Modify Menu will take easy operations on selected objects, such as, Array, Transformation, Modeling, Prune etc. (Fig. 5-1)
[image: ]
5-1 
Figure 5-1 Modify Menu

  Modify 
  View
  Array 
  Transformation 
  Modelling 
  Trim 
  Break Cross Point 
  Auto-Connect 
  Resort 
  Align
3D，，3D，Z。
Except for the movement and rotation operations in the transformation of 3D metafiles, other operations are all not supported. The movement and rotation operations will be synchronized to the 3D metafile transformation information, and the rotation is rotated around the Z-axis. 
[bookmark: _Toc18666][bookmark: _Toc976][bookmark: _Toc64634105][bookmark: _Toc416973457]5.1. Array
Click “Array”, we can see the dialog box as shown in Fig. 5-2:
[image: ]
Fig. 5-2 Array Dialog Box
  Array
  Array Type
  Matrix
  Circular Array
  Horizontal Number 
  Vertical Number
  Horizontal Spacing
  Vertical Spacing
  Spacing Calculation Methods
  Calculate by Offset Distance  
  Calculate by Graph Spacing
  OK 
  Cancel
Rectangle: The graph according to rectangle array.
Matrix ：Indicates that the pattern will be arranged in a rectangle.
Circle array: The graph according to circle array.
[image: ]: Present the graph in undirectional array as per marking sequence.
[image: ]: Indicates that the figures after the array are arranged individually from left to right，At the same time the processing sequence is determined. 
[image: ]: Present the graph in bidirectional array as per making sequence.
[image: ]：Indicates that the pattern after the array is arranged in two directions from left to right and then from right to left, It also determines the processing sequence.
Array Num: The row number.
Array Num: The column number.
Array: The space between two objects on X direction.
Horizontal number：Array is the number of arrays in the X direction.
Array: The space between two objects on Y direction.
Vertical number：Array is the number of arrays in the Y direction.
Lateral spacing：The distance between the x-direction graphics after the Array.
Vertical spacing：The distance between the x-direction graphics after the Array.
Calculate by Offset Distance: The space of the graphs is calculated by offset distance. (Fig. 5-3 (a))
[image: ]
Fig. 5-3 (a) Calculate by Offset Distance (b)
Calculate by Graph offset Distance: The space of the graphs is calculated by graph distance. (Fig. 5-3 (b))
If we select the array type of “Circle”, we can see the dialog box as shown in Fig. 5-4:
[image: ]
Fig. 5-4 Array Dialog Box (Circle)
  Array Type
  Matrix
  Circular Array
  Array Number 
  Radius
  90  Start Angle  90 degree
  30   Angle Spacing  30 degree 
  Centripetal
  Forward Direction
  OK 
  Cancel
[image: ]: The graph’s array is clockwise or anticlockwise, which sets the marking sequence. 
[image: ]：Indicates the arrangement order of the pattern after the array. Whether it is arranged clockwise or anticlockwise also determines the marking order.
Array Number: The graph number.
Components：Indicates how many identical figures you need to array the selected figures
Radius: Array after the graphics accordance circular arrangement. The radius of the circle.
Start Angle: The angle between the starting graphs of the circle.
Start Angle: Decision the initial arrangement angle of the pattern after the array.
Angle: The angle between two graphs.
Angle spacing: The array angle spacing of the pattern after arraying.



[bookmark: _Toc10313][bookmark: _Toc64634106][bookmark: _Toc416973458]5.2. Transformation
When selected, a parameter setting box will appear as shown in Fig. 5-5.
[image: ]
5-5 
Figure 5-5 Transformation Operation Dialog Box
  Transformation
  Location
X  -46.340   X  -46.340 mm
Y  -46.536   Y  -46.536 mm
  Relative Location
  Apply to Copy Object
  Apply



[bookmark: _Toc4316][bookmark: _Toc18805][bookmark: _Toc64634107][bookmark: _Toc416973459]5.2.1. Move
[image: ]: Stroll tool for moving objects
[image: ]: Represents a move transform. The move Transform command can translate the currently selected object.
Position: The coordinates of the currently selected object datum mark.
This function is the same as the Position which is introduced in object label of properties toolbar in Chapter 2.
In absolute coordinates, this function is equivalent to the X and Y functions in the attribute toolbar object label in Chapter 2.
[image: ]Select a datum mark of an object.
Relative Position centere: use relative coordinates
[bookmark: _Hlk32091988][image: ] Apply to Copy Object: This item is used to copy the currently selected object and move it into a new place.
[image: C:\Users\loop\Desktop\8.bmp8]: Activate the modification.
[image: C:\Users\loop\Desktop\8.bmp8] Apply: Activate the modification.
[image: ]: Move selection to a new location
[bookmark: _Toc5727][bookmark: _Toc3525][bookmark: _Toc64634108][bookmark: _Toc416973460]5.2.2. Rotate
[image: ]: Rotate your object.
[image: ]: Represents a rotation transform. The rotation transform command rotates the currently selected object.
When selected, a parameter setting will appear in the Rotation Setting Dialog Box as shown in Fig. 5-6.
[image: ]
Fig. 5-6 Rotation Setting Box
  Transformation
  45.000   Angle  45.000 degree
  Center
X  -38.164   X  -38.164 mm
Y  -41.646   Y  -41.646 mm
  Relative Center
  Apply to Copy Object
  Apply
Angle: Angle to rotate.
Angle: Represents the angle to rotate for the currently selected object.
Center: The coordinates of the currently selected object’s datum mark.


This function is the same as the Center which is introduced in object label of properties toolbar in Chapter 2.
In absolute coordinates, this function is equivalent to the X and Y functions in the attribute toolbar object label in Chapter 2.
[image: ] Select a datum mark of an object, 3D，Z。
[image: ] Select a datum mark of an object, and the property of 3D metafile does not work. It is rotated around the Z-axis by default.
Relative Center: Change the current coordinates into relative coordinates.
[image: C:\Users\loop\Desktop\8.bmp8]: Let the modification of the current object active.
[image: C:\Users\loop\Desktop\8.bmp8] Apply: Let the modification of the current object active.
[image: ]: Move selection to a new location
[image: ]: This item is used to copy the currently selected object and rotate it into a new place.
[image: ] Apply to Copy Object: This item is used to copy the currently selected object and rotate it into a new place.
[bookmark: _Toc21263][bookmark: _Toc18877][bookmark: _Toc64634109][bookmark: _Toc416973461]5.2.3. Mirror
[image: ]: Mirror the currently selected object.
[image: ]: Represents a mirror transform. The mirror Transform command can mirror the currently selected object.
When selecting mirror command, a parameter setting box will appear as shown in Fig. 5-7.
[image: ]
Fig. 5-7 Mirror Setting Box 
  Transformation
  Scale
  Object
  Apply to Copy Object
  Apply
Scale Proportion: The zoom ratio of the X/Y size after being mirrored.
[image: ]: The current object’s horizontal mirror.
[image: ]: The current object’s vertical mirror.
The vertical mirror and horizontal mirror can be activated at the same time, activate the corresponding mirror functions as per requirements in actual use, and make sure not to press the function that is not required.
[image: ]: Select a datum mark of an object.

[image: C:\Users\loop\Desktop\8.bmp8]: Let the modification of the current object active.
[image: ]: Move selection to a new location
[image: ]: This item is used to copy the currently selected object and mirror it into a new place.
[bookmark: _Toc16337][bookmark: _Toc29504][bookmark: _Toc64634110][bookmark: _Toc416973462]5.2.4. Zoom
[image: ]: Zoom your objects. 。
 [image: ] Zoom your objects Represents a scale transform. The zooming transformation command can zoom the currently selected object.
When selected, a dialog box will appear as Fig. 5-8.
[image: ]
Fig. 5-8 Zoom Setting Box
  Transformation
  Size  
X  16.352    X  16.352mm
Y   9.780    Y   9.780mm
  Apply to Copy Object
  Apply
Size: The size after zooming. This function is the same as the Size which is introduced in object label of properties toolbar in Chapter 2.
[image: ]: Select a datum mark of an object.
[image: C:\Users\loop\Desktop\8.bmp8]: Let the modification of the current object active.
[image: C:\Users\loop\Desktop\8.bmp8] Apply: Let the modification of the current object active.
[image: ]: Move selection to a new location
[image: ]: This item is used to copy the object and zoom it into a new place.
[bookmark: _Hlk32092945][image: ] Apply to Copy Object: This item is used to copy the object and zoom it into a new place.
[bookmark: _Toc13840][bookmark: _Toc12691][bookmark: _Toc64634111][bookmark: _Toc416973463]5.2.5. Lean Tilt
[image: ]: Lean the currently selected object, 。
[image: ]: Lean Tilt the currently selected object, and the leaning transformation command can lean the currently selected object.
When selected, a parameter setting box will appear as shown in Fig. 5-9.
[image: ]
Fig. 5-9 Lean Tilt Setting Box
  Transformation
  Lean    
X  0     X  0 degree
Y  0     Y  0 degree
  Apply to Copy Object
  Apply
Angle: The angle the object leans.
Tilt: Represents the slope angle of the currently selected object. 
[image: ]: Select a datum mark of an object.
[image: ]: Let the modification of the current object active.Apply to copy object
Apply

[image: ]: Move selection to a new location
[image: ]: This item is used to copy the currently selected object and lean it into a new place.
[bookmark: _Toc20741][bookmark: _Toc10854][bookmark: _Toc64634112][bookmark: _Toc416973464]5.3. Plastic Modeling
When selected, a parameter setting box will appear as show in Fig. 5-10.
[image: ]
Fig. 5-10 Plastic Modeling
[image: ]: Joint two close intersect areas into one.
[image: ]: Indicates welding, you can combine two intersecting closed areas into a closed area.
[image: ]: Shear a close intersect area contained in another.
[image: ]: Indicates trim, you can trim an enclosed area from a drawing contained in another area.
[image: ]: Pick up the intersect part of two close intersect areas.
[image: ]:Indicates cross，You can combine two intersecting closed areas into a closed area, and only the intersecting parts are retained.



[bookmark: _Toc12716][bookmark: _Toc13077][bookmark: _Toc64634113][bookmark: _Toc416973465]5.4. Trim prune
Trim is used for shearing curve in graph. After users select it and when the mouse is moved to the curve to be sheared, the mouse will be of a scissor shape and the the curve to be sheared will become light blue, as shown in Fig. 5-11. By clicking the left mouse button at this time, the curve will be sheared.
The trimming operation is used to trim the curve in the graph. After the user clicks the trimming command, when the mouse moves to the curve that can be trimmed, the mouse will be scissor shaped, and the curve that can be trimmed will be sky blue, as shown in Figure 5-11. At this time, if you click the left mouse button, the line can be trimmed.
[image: ]
Fig. 5-11 Example of Trim Operation
[bookmark: _Toc10261][bookmark: _Toc26437][bookmark: _Toc64634114][bookmark: _Toc416973466]5.5. Break Cross Point Remove intersections
When users click “Break Cross Point”, the following dialog box as shown in Fig. 5-14 will pop-up:
[image: ]
Fig. 5-12 Dialog Box of Breaking of Cross Point Remove intersections

[bookmark: _Toc21112][bookmark: _Toc11905]Length of Cross Point Cut length: It means the length of the Crossover line part that we designed, as shown in Fig. 5-12. Take the following Fig. 5-13 for example:
[image: ]
（a）Before Breaking Cross Point         (b)After Breaking Cross Point
（a）Before removing the intersection     (b)After removal of intersections
[bookmark: _Toc13556][bookmark: _Toc10476][bookmark: _Toc31015]Fig. 5-13 Example of Breaking Cross Point Cut length
[bookmark: _Toc64634115][bookmark: _Toc416973467]5.6. Auto-Connect
When selected, a dialog box will appear as shown in Fig. 5-14.
Auto-Connect Error Automatic connection pitch: If the distance between two curves’ starting and ending points is less than the parameter set, the two curves will be jointed into one.
[image: ]
[bookmark: _Toc28609]Fig. 5-14 Auto-Connect Dialog Box
 Automatic connection pitch



[bookmark: _Toc64634116]5.7. Resort Sorting
Select this command in the modify menu or select [image: 1-1]from the main interface。The software will mark through your chosen direction
Select this command in the modify menu or select [image: 1-1]from the main interface. Draw multiple objects, click Sort, the direction of blue arrow in the working area indicates the current marking order. The sorting icon appears above the main interface, as shown below
[image: 1-2]
Fig.5-15 Resort Sorting
[bookmark: _Toc64634117][bookmark: _Toc416973468]5.8. Align alignment
Command “Align” will be available only when more than one object is selected in the workspace. “Align” is used to align the objects users select on the two-dimensional plane. There are several ways to align:
[image: ]Center point alignment: All objects align center. This way may cause moves on both horizontal and vertical directions.
[image: ] Align Left: All objects align left.
[image: ] Align Right: All objects align right.
[image: ] Top Align up: All objects align top.
[image: ] Bottom Align below: All objects align bottom.
Vertical Centered vertically alignment: All objects align vertical. These three ways above only support to move objects on horizontal direction.
Centered Horizontal alignment: All objects align horizontal. These three ways above only support to move objects on vertical direction.
：
，、，，。
Graph Equidistance Function: After selecting the object graphs, clicking the horizontal and vertical equidistances, the graphs will be equal in distance from the order of the object list bar.
[image: ]Graphic isometric function: Select the object graph, click horizontal and vertical isometric, the graph will be in the order of object list column, and the distance between them will be equal.
[bookmark: _Toc12344][bookmark: _Toc20119]Note: The benchmark to align is according to the last object users select, and other objects align behind it. If you select several objects by “Frame Select”, then the system will hardly identify which is the last one, and this may cause unexpected alignment. It is strongly recommended that you select the object which is to be the benchmark at the end when you want to align several objects.
Note: The benchmark to align is according to the last object users select, and other objects align behind it. When you use it, first click the first object, then drag to select multiple objects or press "Ctrl" to click multiple objects, all of which are based on the first selected object.
[bookmark: _Toc64634118][bookmark: _Toc416973469]6. View Menu
The View Menu is used for setting every option for view in the software, as shown in Fig. 6-1.
[image: ] [image: ]
Fig.6-1 View menu and status bar menu
  System Toolbar 
(s)   Status Bar(s)
  Drawing Toolbar 
  Zoom Toolbar 
  Guide Toolbar 
   Alignment Toolbar
  Node Formula Bar 
  Object List Window 
  Object Property Window
  Marking Parameter Bar 
  Marking Control Bar 
  Display Ruler 
  Display Network
  Display Guide Line  
  Display Path 
  Snap Network 
  Snap Guide Line 
  Snap Object 
  Path Preview 
IO  IO State 
Gcode  Generate Gcode
[bookmark: _Toc27271][bookmark: _Toc11264][bookmark: _Toc64634119]6.1. Zoom Toolbar
The Toolbar of the zoom Menu is [image: ], and there are seven types for different requirements.
[image: ]: This item is used for filling the whole view area with the appointed area. Users may use mouse to select rectangle area to zoom in. If pressing the right button of the mouse, the current view will zoom out for one time with the mouse pointer’s position as the center; and if pressing the left button of the mouse, the current view will zoom in for one time with the mouse pointer’s position as the center.
[image: ]: Fill the whole view area with the area you specified for observation. You need to use the mouse to select the enlarged rectangular area. If you press the right mouse button directly, the current view will be zoomed out by one time with the current mouse position as the center. If you press the left mouse button directly, the current view will be zoomed in by one time with the current mouse position as the center.
[image: ]: To move the current view.
[image: ]: Zoom in.
[image: ]: Zoom out.
[image: ]: Fill the whole view area with all the objects.
[image: ]: Fill the whole view area with only the selected objects.
[image: ]: Fill the whole view area with the whole workspace.
[bookmark: _Toc13834][bookmark: _Toc4544][bookmark: _Toc64634120][bookmark: _Toc416973471][bookmark: _Toc5934][bookmark: _Toc25804]6.2. Ruler/Gridding/Guide Line
[bookmark: _Toc64634121] display ruler /display grid /display guide line
[bookmark: _Toc19627][bookmark: _Toc31161]There are Horizontal Gauge, Vertical Gauge, Gridding and Guide Line for selection.
Displays horizontal and vertical rulers, grid points, and guides.
[bookmark: _Toc15197][bookmark: _Toc64634122][bookmark: _Toc416973472]6.3. Snap Capture Grid
[bookmark: _Toc28538][bookmark: _Toc12569]This item is used for automatically putting the dots you draw on the grid.
[bookmark: _Toc64634123][bookmark: _Toc16149]6.4. Snap Capture Guide Line
[bookmark: _Toc30510][bookmark: _Toc29052]This item is used for making objects approach to guide lines automatically when moving the object.
The capture grid capability enables the points you draw to automatically be on the grid points in the workspace.
[bookmark: _Toc22559][bookmark: _Toc64634124][bookmark: _Toc416973474]6.5. Snap Capture Objects
[bookmark: _Toc29183][bookmark: _Toc4242]During performing some operations, this item is used for automatically snapping an object’s top, center, nodes, circle center, intersect points, etc.
[bookmark: _Toc25374][bookmark: _Toc64634125][bookmark: _Toc414777241][bookmark: _Toc416973475]6.6. System Menu Bar/Toolbar/Status Bar/Interface Window Bar
Software supports many toolbars to achieve different functions. Toolbars can be either displayed or hidden by selecting corresponding options in View Menu; and also the Status Bar can be displayed or hidden, either. When there is a “√” selected in front of the submenu, the corresponding toolbars on Status Bar is visible, and if not, they are hidden.
[bookmark: _Toc14265][bookmark: _Toc64634126]6.7. IO State
Check current input and output state, as shown in Fig. 6-2.
Check the status of current input and output ports. If checked, figure 6-2 will be displayed:
[image: ]
Fig.6-2 IO Status
  Input Port
  Output Port

[bookmark: _Toc64634127]6.8. display Path preview 
Select this function to see the path of the drawing.
[bookmark: _Toc64634128]7. Special
	SeaCad ， 7-1 。
Various options of the special menu in SeaCad software are shown in Figure 7-1.
[image: ]
Fig.7-1 Special
  Change Text
  Serial Number Text
  Set Quick Print Button
SQL  SQL Database Text
[bookmark: _Toc64634129]7.1. Change Text
Click change text, follow dialog window will pop-up, as shown in Fig. 7-2.
[image: ]
Figure 7-2 Change Text
The content under ‘text’ is to be replaced, the content under ‘change to’ is that after replace.
  Change Text
  Source Text
  Transformed
  OK
  Exit
[bookmark: _Toc64634130]7.2. Serial number text
All serial numbers under the current file are directly increased or decreased according to their respective increments, or reset to the starting serial number without marking.

[bookmark: _Toc64634131][bookmark: _Toc416973476]8. Laser
“Laser” menu mainly aims at expansion axis control, as shown in Fig. 7-1 below:
[image: ]
Fig.8-1 Laser
  Rotation and Movement Test
  Rotation Angle Marking
  Extended Axis Marking
  Rotate Text Marking
  MultiFile Marking








[bookmark: _Toc64634132]8.1. Rotate and Move test（Lite version does not support this feature）
	“Rotary Marking” is performed according to the angle of rotation axis.
The parameters used to set and maintain the extension axis.
[image: ]
8-2 
Figure 8-2 Rotation Configuration and Test
  Configuration Parameters 
1  Extended Axis 1
  Print by Facing to Characters   
  Invert 
  Rotation Axis 
  Reduction Ratio 
  Pulses per Revolution 
  Distance per Revolution
  -1000  Minimum Coordinates  -1000 mm
   1000  Maximum Coordinates  1000 mm
   100/  Minimum Speed   100 pulses/second
   5000/  Maximum Speed   5000 pulses/second
   100  Acceleration Time  100 ms
   700 /  Motor Startup Speed   700 pulses/second 
   6400 /  Motor Running Speed   6400 pulses/second
  Zero
  5000  Return-to-origin Speed  5000 pulses
  100  Return-to-origin Timeout  100 seconds  
  Accurate Back to Zero
    0.2  Backlash Compensation   0.2 mm 
    0   Dislocation Compensation   0 mm 
  Test  
  OK 
  Close
Invert: It refers that the expansion axis rotates in the opposite direction. When it is checked, it means the expansion axis will invert;
Reversal: It refers to the movement in the opposite direction of the extension axis; when checked, it indicates that the extension axis is reversed.
：。
Print by Facing to Characters: Change the sequential order of text marking.
Character to meet：Change the sequence of text marking.
Pulses per Round: The pulse (subdivision of driving motor) numbers each round that the expansion axis rotating. It can be set according to the motor parameter.
number of：
Distance per Round per revplution：The distance each round that the expansion axis rotating，Click the setting button "..." to calculate a more accurate distance per round.
[image: ]
Fig.8-3 Extended axis accuracy setting
  Distance Calculation for Extended Axis per Revolution 
  Reverse
  Movement Revolutions 
  Movement
  Actual Movement Distance
  OK 
  Close
Min Coordinate: The smallest coordinate in which the extended axis can move, in millimeters.
Maximum Coordinate: The maximum coordinate of the extended axis that can be moved, in millimeters.
Min. Speed： The minimum rotary speed of expansion axis.
Min. Coordinate: The minimum speed of the extended axis energy movement, unit pulse / second.
Max. Speed: The maximum rotary speed of expansion axis.
Max. Coordinate: The maximum speed of the extended axis, unit pulse / second.
Acc. Time: Acceleration time needed when expansion axis moves from minimum speed (starting speed of motor) to maximum speed.
Acceleration: The time, in milliseconds, required for the extended shaft to accelerate from the minimum speed (starting speed of the motor) to operation.
Go to Start Position After Finished: When it is checked, the expansion axis will go back to the initial position after finishing marking.

Start Speed Motor starting：Set motor start speed, unit is pulse/s。
Motor Speed Motor running: The rotating speed of motor.
Rotation axis: Select it, it's indicates that current expansion axis is rotation axis. 
Reduction ratio：If the motor is directly connected to the shaft, the reduction ratio is 1; if there is a reduction mechanism in the middle, it is the reduction ratio of the reduction mechanism.
Part Diameter: It is used for setting the external wall diameter of round parts and converting graphs in workspace into the accurate rotation angle.
Zero: Whether current expansion axis has zero signal. When expansion axis has not activated zero signal, it cannot set up an absolute coordinate system. Then, it is required to manually adjust the site to make every processing stay in the same site. The system takes the current expansion axis point as default original point before processing.
Zero point: Whether the current extension axis has zero signal. When there is no enable zero signal for the extended axis, an absolute coordinate system cannot be established for the extended axis. In this case, it is necessary to adjust the position manually so that each machining is in the same position. Before each machining, the system takes the current extended axis position as the default zero position.
If the zero is selected, the system will automatically look for zero point when employing the expansion axis function. After finding the zero point, an absolute coordinate system will be built for the expansion axis. If the system fails to find the zero point, the expansion function will not be activated properly until the time set for “Zero Time Out” is over.
，[image: ]，。
If there is no zero signal, the zero must be checked to the[image: ] zero state, that is, the zero signal state is not used.
Speed of Go Zero: The moving speed of expansion axis looking for zero signal.
Zero return: The speed at which the extended axis seeks the zero point signal.
Zero Time Out: Set the time of expansion axis finding zero point. If it overruns, the system will present “overtime”.
Zero return: Set the time for the extension axis to find the zero point. If the time exceeds this time, the system will prompt "return to zero timeout".
Accurate Zero: When it is selected, it is required to receive three signals before going back to zero; if not selected, only one signal is required for going zero.
Gap Clearance compensation: Used to set the interval compensation between each independent figure. For example, the interval between two figures is set to 10mm. If the mark is 10.1, then the gap compensation bit - (10.1-10) =- 0.1.
Offset compensation：When the graphics are stitched, it may cause mismatch phenomenon. This parameter is used to eliminate the misalignment.
Rotation Test：Test Rotary Axis.
[image: ]
Fig.8-4 Rotate test
  Rotation Test
  Rotation Axis
  Working Diameter
  Pulses
  Invert
  Corotation
  Emergency Stop
[bookmark: _Toc64634133]8.2. Rotation Angle Marking（Lite version does not support this feature）
[bookmark: _Toc64634134]8.2.1Interface description
"Rotation Angle Marking" is to perform rotation marking according to the angle of the rotation axis to process the entire figure.
Click on the "Rotation Angle Marking" menu item under "Laser" to display the following dialog box:
[image: ]
Fig.8-5 Rotate angle mark
  Rotation Angle Marking
  Rotation Axis 
  Stop 
   Total Number of Processing
  Continuous Processing 
  Selective Processing
  Input Port Marking 
  Marking by Graphs
  Equiangular Marking
360  360 Degree Rotation Marking 
   Times per Week
  Return to Start Position after Marking 
  Number of Completions 
  Total Time 
  Red Light Indicator 
  Marking 
  Parameters 
  Exit 
……    Marking Not Started......
，：
In the dialog box, the data items are described as follows:

Total Number: The total counts that the marking command should be executed. If checking the “Continuous”, the marking number will not be limited by the total number;
Rotary Axis：Choose which axis to use；
Continuous Mark: If it is checked, it will not be controlled by the total number, and it will perform continuous marking for graphs or text contents displayed in the workspace.
Mark Selected: If it is checked, only those selected graphs will be marked; otherwise, all the graphs will be marked;
Input trig port marking: Specify an input port and the marking can be triggered through the IO port.
Overall Marking of Graph: Mark the individual graph or text as a whole at a time, and after marking an individual graph, rotate for an angle.
Press icon: After each engraving, rotate the z-axis coordinate value (angle) of the graph. Different graphs can set different rotation angles
Increment: The angle that the column should rotate after mark each figure. It is the angle interval between two adjacent figures 
Increment mark: Rotate the mark according to the set angle interval.

360 degree mark: Selected to mark the figure on the column evenly 
360 degree rotating mark: Set how many times to mark the figure in a week;
Go to Start Position After Finished: When it is checked, the expansion axis will go back to the initial position after finishing marking.
Mark back to the starting point: When this option is checked, the rotation axis will return to the starting point of the marking.
Part Completion times: The total counts that the marking command has been executed;
R：Reset the marking status and clear marking count；
Total Time： Total time of marking.
[bookmark: _Toc64634135]8.2.2Functional operation
8.2.2.1 Red light
Click on the "red light " button, you can see the red indicator of the current graphics.
8.2.2.2 Mark
Click "Mark", and the software marks according to the set parameters.
8.2.2.3 Parameters
Click “Parameters” to configure specific parameters for the rotary marking, and the following parameter configuration dialog box is displayed. The expansion axes 1, 2, 3, and 4 correspond to the expansion axes 1-4 (Refer to section 8.1 for related parameters).
Click "parameters" to configure the relevant parameters of the rotation axis. (refer to 8.1 for parameter description).
8.2.2.4 ESC drop out
Click "ESE drop out ", the system will save the configured parameters for the next use.
Note: If you click the "X" button in the upper right corner of the dialog, 	the modified parameters are not saved.

[bookmark: _Toc64634136][bookmark: _Toc416973479]8.3. Expansion Axis Marking（Lite version does not support this feature）
The expansion axis marking function divides the picture into a specified size and then mark while rotating. The interface is as follows:
The extended axis marking function is to divide the entity into specified sizes and then splice the marking while rotating. The interface is as follows:
[image: ]
Fig.8-6 Extend axis mark
  Extended Axis Marking
   Total Number of Processing
  Continuous Processing 
  Selective Processing
  Input Port Marking 
  Return to Zero After the Completion of Marking
  Return to Zero After the Completion of Red Light
  Part
  Total Time
  Extended Axis
  Extended Axis Direction
  Movement Step Length
  Workpiece Diameter 
  Emergency Stop 
  Red Light Indicator 
  Marking 
  Parameters 
  Exit 
……    Marking Not Started......
：。
Extended Axis Direction: Select the use direction of the rotation axis.
Axis Diameter Workpiece：Diameter of Axis.
：。
Movement Step Length: The size of the metafile split.
[bookmark: _Toc7726][bookmark: _Toc17236][bookmark: _Toc64634137]8.4. Rotate Text Mark（Lite version does not support this feature）
Rotate Text Mark is a marking method in which the text is divided by each character and then the individual characters are marked while being rotated.
“”“”，as shown in Fig.8-9：
Click the “Rotation Text Marking” in the “Laser” menu of the menu bar to open the rotation text marking dialog box, as shown in Fig.8-9:
[image: ]
Figure.8-9 Rotate Text Mark
The configuration parameters are the same as those for the Rotary marking.
  Rotation Text Marking
   Total Number of Processing
  Continuous Processing 
  Selective Processing
  Input Port Marking 
  Return to Zero After the Completion of Marking
  Return to Zero After the Completion of Red Light
  Part
  Total Time
  Extended Axis
  Extended Axis Direction
  Workpiece Diameter 
  Movement Step Length
  Stop 
  Red Light Indicator 
  Marking 
  Parameters 
  Exit 
……    Marking Not Started......
[bookmark: _Toc64634138]8.6. Multi-File Mark 
“Multi-File Mark” module is able to mark repeatedly different *.orz files, avoiding changingthe files. That function menu is shown in figure 8-10: 
The function of "multi file marking" is used to trigger IO to mark multiple different marking files to avoid frequent changes of marking files. The function menu is: "laser" - > "multi file marking".
The left text box shows the file name, and the right border shows a preview image of the selected file after checking the preview.
The operation interface is as shown in Figure 8-10: the text box on the left displays the file name, and the preview graphic of the selected file appears after the preview graphic is checked on the right border. Double click the file name to open the engraving file in the main interface for editing.
Double-click on the file name and open the marking file on the main screen to edit it.
[image: ]
Fig.8-10 Multifile Mark
  MultiFile Marking 
  Solution Name 
  Preview Graph 
  Related Equipment 
  File 
  Marking 
  Trigger Condition 
  Add  
  Delete 
  Move Up 
  Move Down 
  Modify 
  Frequency Zero 
  Enabling Effective 
  Trigger in the Same Port Sequence
  Trigger All on the Same Port 
  Open Solution 
  Save Solution
  Marking 
  Exit
[bookmark: _Toc64634139]8.6.1. File Manage
· Add: Add .orz files. The dialog box pops up as Figure 8-38 after click “add” button. Setting I/O control conditional for files, and automatically mark files when board accept the IO signal in mark status.
[image: ]
Fig.8-11 File Menu
  File
  File Name
I/O  I/O Control Condition
  Current Marking
  OK
  Close
Gray：Gray means not used 
Blank：Blank means low level 
Black Hook：Black Hook means high level.
· Delete: delete files.
· Prev Next "Move up", "move down": change the order of files.
· Modify: change file selected and IO control conditional
[bookmark: _Toc64634140]8.8.2. function Option
One port trigger Sequential trigger on the：Use a port to mark the preset files in order.
：，。
Trigger All on the Same Port: If different documents are the same port, then triggering the port once will mark all documents.
Open plan：Open saved multi-file marking scheme.
Save plan：Save the currently designed multi-document marking content as a scheme.
Mark：After clicking, software will enter the state of waiting for the IO 	signal to trigger. At this time, the IO signal can be triggered to mark the corresponding document.
[image: ]
Fig.8-12 Marking Interface
  Trigger in the Same Port Sequence
  Open Solution 
  Save Solution
  Stop
  Exit
IO  Wait for IO Signal
[bookmark: _Toc9572][bookmark: _Toc8417][bookmark: _Toc64634141][bookmark: _Toc416973482]9. Mark parametr
Including single-card marking and multi-card marking.
[bookmark: _Toc64634142]9.1. Pen Parameter Management
9.1.1. Pen Parameter List
SeaCAD257，256，0256，0（）。
In SeaCAD, there are 257 pens in each file, corresponding to the top 256 pens in the processing property bar, the pen number ranges from 0 to 256, where the pen 0 is the pen template parameter (other pen number parameters can be modified based on the pen number).
9-1。
As shown in Figure 9-1, it is the marking control bar.
[image: ]
Fig.9-1 Marking tool bar
  Marking Parameter Bar 
  Pen Number 
  Toggle 
  Name 
  Processing 
  Use Default Parameters 
  Pen Number 
（）  Processing Number (piece)
（mm/s）   Speed (mm/s)
（%）   Power (%)
（KHZ）   Frequency (KHZ)
（ns）   Pulse Width (ns)
   Light-on Delay
  Light-off Delay 
  End Delay 
  Corner Delay 
  Flare Demonstration 
  Advanced Settings
  Parameter Name 
  Save 
  Select Parameters From Parameter Library
  Set as Default Parameters
[image: C:\Users\loop\Desktop\122.bmp122]，，。
[image: ] Open indicates that the current pen is to be processed, that is, when the processed object corresponding to the current pen number to be processed, double click this icon to change it.
[image: C:\Users\loop\Desktop\13.bmp13]，。
[image: ]Turn Off indicates that the current pen is not processed, that is, when the processed object corresponding to the current pen number, it is not processed.

Color: The current pen’s color, which will be displayed when the object is corresponding to the current pen number, 。
Color: The current pen’s color, which will be displayed when the object is corresponding to the current pen number, double click the color bar to change the color.
：。9-2。
Parameter Application Button: When the user presses the parameter application button, the pen number of the currently selected object will be changed to the corresponding button pen number. As shown in Figure 9-2.
[image: ]
9-2 
Figure 9-2 Parameter Application Button 
9-3。
When the user presses the right mouse button in the current list, the right button menu as shown in Figure 9-3 will pop up.
[image: ]
9-3 
Figure 9-3 Right Button Menu
  Select List
  Apply to the Selected Objects
  Set as Default Pen Number
9.1.2.  Advanced Settings
[image: C:\Users\loop\Desktop\10.bmp10]
Here we will introduce the specific meaning of each parameter in details.
  Pen Number Parameter  
  Current Pen Number 
  Parameter Name 
  Start 
  Color 
（）  Processing Number (piece) 
（mm/s）  Speed (mm/s) 
（%）  Power (%) 
（A）  Current (A)
（KHZ）  Frequency (KHZ) 
MOPA（us）  MOPA Pulse Width (ns) 
Q（us）  Q Pulse Width (ns)  
（us）  Light-on Delay (us)
（us）  Light-off Delay (us)
（us）  End Delay (us)
（us）  Corner Delay (us) 
（mm）  Marking Step Distance (mm)
（us）  Inter Step Delay (us) 
  Advanced Parameters 
  Jump Speed 
  Jump Position Delay 
  Jump Distance Delay 
  Jump Delay Limit
  Minimum Jump Delay 
  Maximum Jump Distance 
  End Point Compensation 
  Acceleration Distance 
  Dotting Time 
  Vector Dotting Mode 
  Points per Pulse 
  Light-on Lag 
  Dithering
  Circle Diameter 
  Spacing 
  Add Point at the End 
  Quantity 
  Distance 
  Dotting Time 
  Dotting Times 
  Reset  
  Set as Default Pen Number 
  OK
  Close
: 
Basic Parameter Area:
Current Pen Number: The set of marking parameters currently used. In SeaCAD, the concept of “pen” is equivalent to a set of given marking parameters.
Marking Quantity processing (pieces): The marking times for each object during one marking are equivalent to the marking quantity in its marking parameters.
Speed: The marking speed of current marking parameters.
Power: This item indicates the power percentage of the current marking parameter, and 100% refers to the maximum power of current laser.
Frequency: The laser’s frequency in the current marking parameter.
Duty Ratio Mopa pulse width: The ratio of laser pulse duration to pulse period.
Start TC: Delay time for laser ON at the beginning of marking. The proper Start TC parameters set can eliminate the “match head” appears at the beginning of marking, while the too large ones may cause miss at the initial segment. This value may be negative, which indicates that the laser emits light in advance.
Opening delay: Delay time of laser on at the beginning of marking. Setting the appropriate delay parameter can remove the "match head" at the beginning of marking, but if the delay parameter setting is too large, it will lead to the lack of pen at the beginning. It can be a negative value, which means that the laser light comes out ahead of time.
Laser Off TC Delay time for laser OFF at the end of marking. The proper Laser Off TC parameters set can eliminate the misclosure phenomenon appears at the end of marking, while the too large ones may cause “watch head” appears at the termination segment. This value cannot be negative.
Off light delay: Delay time for laser off at the end of marking. Setting the appropriate light off delay parameter can remove the non closing phenomenon when the marking is completed, but if the light off delay setting is too large, the end segment will appear "match head". Cannot be negative.
End TC: Generally, there is a period of response time from sending laser OFF command to completely laser OFF, proper End TC is set to provide the laser with sufficient response time for laser OFF, so as to make the laser perform next marking in case of totally OFF to prevent light leakage and point dragging.
End delay: Generally, it takes a period of response time from the time when the light off command is sent to the time when the laser is completely shut down. Setting an appropriate end delay is to give the laser a sufficient light off response time, so as to achieve the purpose of making the laser carry out the next marking when the laser is completely shut down, and prevent the light from leaking and the phenomenon of point rejection.
Polygon TC: Delay time between each segment during the marking. The proper Polygon TC parameters set can eliminate the circular angle appears during right angle marking, while the too large ones may cause marking time increase and double points at the corner.

Corner delay: Delay time between each segment during marking. If the corner delay is set too much, the marking time will increase, and the corner will have the key phenomenon.
: 
Advanced Configs Parameter Area:
Jump Speed: Set a jump speed corresponded by the current parameter.
Jump Position: Value of Jump Position TC. Jump position delay value.
Jump Distance: Value of Jump Distance TC. Jump distance delay value.
After each jump movement, the system will delay some time, and then execute the next command. The actual delay time is calculated by the following formula:
Jump TC = Jump Position TC + Jump Distance × Jump Distance TC
Jump delay = jump position delay + jump distance × jump distance delay;
End Point Compensation: This parameter requires being set only when the end point fails to be put in place by TC parameter adjustment during high-speed marking, by means of proceeding to marking a straight line with length of end point compensation distance at the end of marking compulsively. Negative value is supported.
End Point: Generally, this parameter does not need to be set. Only in high-speed machining, when the delay parameter cannot be adjusted to make the end point in place, this value is set to force the marking of a straight line with the length of the compensation distance of the end point at the end of machining. Negative values are acceptable.
Acceleration Distance: This parameter may be set properly to eliminate the uneven dotting at initial marking segment.
Dotting Time: It indicates light emitting time of each point in case that point objects exist.
Vector Dotting Mode: It indicates to compulsively specify the fixed pulse number given out by the laser during each point marking.
Add Point at the End: It is used to solve the problem of laser end shining. The software will automatically add points at the end of each pen, but will not display it as an object.
Quantity number: Quantity number of points added at the end.
Distance: Distance between the points added at the end.
Dotting Time: Marking time for each point added at the end.
Dotting Times: Marking times for each point added at the end.
[bookmark: _Toc28976][bookmark: _Toc21935][bookmark: _Toc64634143][bookmark: _Toc416973485][bookmark: _Toc31252][bookmark: _Toc21077]9.2.EquipmentParameter  Region parameter 
[bookmark: _Toc64634144][bookmark: _Toc416973486]9.2.1.Field Parameter  Configuration Config[default]
See Fig. 9-4 for the field parameter of equipment:
[image: C:\Users\loop\Desktop\91.bmp91]
Figure.9-4 Field Parameter Configuration Config[default]
 [default]  Configuration Parameters [default]
  Area 
  Laser Control 
  Port 
  Others 
  Red Light Indicator 
  Board Information
  Appearance 
  Area Size 
X  Offset X  
Y  Offset Y 
  Angle 
  Maximum Line Length 
  Use Correction File 
XY  XY Interchange 
X  Reverse X 
Y  Reverse Y 
  Scale 
  Scale 
  Equal Scale Method 
  Use Configuration File
  Calculate Recommended Value 
  Password 
  Password 
  Save Parameter As 
  OK
  Close
Field Area Size: The actual widest range for marking corresponded by the scanhead.。
Offset X: The offset distance of scanhead center in X direction from field lens center.
Offset Y: The offset distance of scanhead center in Y direction from field lens center.
Angle: Adjust the angle of the galvanometer.
Maximum line length: The maximum length of the line segment that is divided by the figure. It is used to split the line segment beforehand to deliver the data, so as to improve the marking accuracy.
Use the Calibration File: Use the calibration file generated by external calibration program to calibrate the scanhead.
XY Change: Change the axes corresponding to the original galvanometer signal 1 and signal 2.
reverseX/reverseY: The opposite direction of the current scanhead.
[image: ]indicates the barrel distortion or pincushion distortion calibration coefficient with default of 1.0 (parameter range: 0.875-1.125).
[image: ] indicates the parallelogram calibration coefficient with default of 1.0 (parameter range: 0.875-1.125).
[image: 1-2]indicates the trapezium calibration，with default of 1.0 (parameter range: 0.875-1.125).
Scale: It refers to the flex percentage, and the default is 100%. This parameter will be adjusted when the trim size marked is different from the setting size. If the trim size is smaller than the designed one, users can raise this parameter; if the trim size is bigger than the designed one, users can lower this parameter.
Note: If there are some distortions with the laser scanhead, users must firstly adjust the distortions and then the flex percentage.
During scale setting, we may press the button [image: 2015041411097772] directly, and a dialog box like Fig. 9-5 will be popped up. After we input the set size in software and the actual marking size measured, the software will automatically calculate the flex percentage.
[image: C:\Users\loop\Desktop\10.bmp10]
  Calculation Scale
  Target Marking Size
  Actual Marking Size
  OK
  Cancel
Fig.9-5 Calculate scale
：（10.2）。
Equal Scale Method: Whether to use the bisectrices to calculate the zooming scale during correction (see 10.2 manual correction for details).

Go to Specified Position after Marking: After the completion of current marking, move the scanhead to its specified position.
Password: Set the current parameters can only be changed by entering the password。
[bookmark: _Toc20630][bookmark: _Toc14811][bookmark: _Toc416973487]9.2.2. Laser Parameter
See Fig. 9-6 for the laser parameter of equipment:
[image: C:\Users\loop\Desktop\8.bmp8]
 [default]  Configuration Parameters [default]
  Area 
  Laser Control 
  Port 
  Others 
  Red Light Indicator 
  Board Information
  Laser Type
PWM  Enable PWM Signal Output
  Toggle 
Violet  Enable Violet Laser First Pulse Suppression
PWM  Maximum PWM Signal
PWM  Minimum PWM Signal
  Power Mapping
  UV Analog Red Light Mode
  Pulse Width Invert
  Enable Preionization
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  Pulse Frequency
/  Enable Power Ramp Up/Ramp Down  
  Type 
  Light Leakage Treatment  
MO  Start MO Delay
  Initial Power 
  Power Increment 
  40  First Pulse Suppression  40 microseconds
  Enable Pulse Width Setting
  Do not Detect Laser Feedback Signal
SPI  Waveform SPI First Pulse Suppression
  Initial Power 
  Continuous Light Mode
   Send
Q  Q Pulse Width
Q  Minimum Q Pulse Width
Q  Maximum Q Pulse Width
  Analog Output
  Enable Current Output
  Enable Frequency Analog Output
  Enable Analog First Pulse Suppression
  Current Mapping
  Frequency Mapping
  Test Laser
  OK
  Close
Figure.9-6 Laser Control
Please carry out the adjustment as per the actual parameters of laser machine.
[bookmark: _Toc29176][bookmark: _Toc13333][bookmark: _Toc416973488]9.2.3. Port Parameter
See Fig. 9-7 for the equipment port parameter.
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 [default]  Configuration Parameters [default]
  Area 
  Laser Control 
  Port 
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  Red Light Indicator 
  Board Information
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  Prompt Message When Stopping Processing
  Ignore Input Signal
  Ignore Input Signal
  Output Port for Laser Power Supply
  Port
  Output Port for Red Light Indicator 
  Output Port
  Input Port
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  Output Port
  Gate Port
  Input Port
  Laser Ready Port
  Output Port
  Input Port
IO  Output IO After Finishing Marking 
  Pulse Width
  Mark Starting Port
  Input Port
  Start Signal Pulse Mode
  Filter Time
  OK
  Close

Figure.9-7 Port
Input Port of Stopping Marking: Certain input port is specified as marking stopping port. During marking process, if the system detects there is a corresponding input signal, the current marking operation will be ended, and prompt the users with error information.
Gate Port: Check the port signals for safety gate opening and closing and make sure the marking will automatically stop in case of safety gate opening (red light indication may continue being used) so as to protect the operators from being burnt.
Laser Power Supply Output Port: This port may be used to control the on-off of laser power supply.
Red Light Pointer Output Port: The system will output high level to the appointed output port during red light pointer.
Mark Output Port: The system will output high level to the appointed output port during marking.
Mark Starting Port: In idle state, the system will start marking automatically if high level is output by the appointed input port.
Start Signal Pulse Mode: Checking this option means the start signal is marked by software in pulse mode, even for continuous level input, the software only reads one pulse. Otherwise the input port marked is of continuous level.
9.1.2.4. Red Light
[image: C:\Users\loop\Desktop\6.bmp6]
 [default]  Configuration Parameters [default]
  Area 
  Laser Control 
  Port 
  Others 
  Red Light Indicator 
  Board Information
  Enable Port Red Light Marking
  Red Light Style 
  Graphic External Rectangular Box
  Red Light Speed
X  Offset X  
Y  Offset Y
X  Size Scale X
Y  Size Scale Y
  Built-in Red Light Mode
  Red Light Preview
  OK
  Close
Figure.9-10 Red Light
Red light style: Used to select the red light to display the bounding rectangle of the figure or the outline of the figure.
Red Light Speed: It indicates the system movement speed in case of red light pointer.
Offset Position: It indicates the system movement offset position in case of red light pointer and may be used to compensate the position error between red light and actual laser.
Size Scale: It refers to the size deviation between red light and laser, by adjusting which the two can completely coincide.

[bookmark: _Toc30164][bookmark: _Toc5992]9.1.2.5. Others
[image: C:\Users\loop\Desktop\5.bmp5]
 [default]  Configuration Parameters [default]
  Area 
  Laser Control 
  Port 
  Others 
  Red Light Indicator 
  Board Information
  Delay for Starting Marking
  Delay for Finishing Marking
  Maximum Speed
  Minimum Speed
  Display the Dialog Box for Starting Marking
  
Forbid Processing after Designated Processing Number is Achieved
   2655  Total Processing Time  2655 milli
  Total Parts
  OK
  Close
Figure.9-11 Others
Delay for Starting Marking: Start the marking after delay of appointed time at the beginning of each marking.
Delay for Finishing Marking: Finish the marking after delay of appointed time at the end of each marking.
Forbid Marking after Designated Marking Number is Achieved: When the parts number reaches the total marking number designated, the system will pop up a dialog box to prompt that “the current number has exceeded the total marking number, please reset it, and then start marking”.
Display the Dialog Box for Starting Marking: After checking, it will prompt a dialog box of “whether to start marking” for each time selecting marking, as shown in Fig. 9-12.
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  Tip
？  Do you start marking?
  OK
  Cancel
Figure.9-12 Start Marking Dialog
[bookmark: _Toc26706][bookmark: _Toc31178][bookmark: _Toc64634145]9.1.3.Mark
The Marking dialog box is at the bottom of the SeaCAD interface, as shown in Fig.9-13.
[image: C:\Users\loop\Desktop\11.bmp11]
  Red Light
  Marking 
  Continuous Processing 
  Part
  Selective Processing 
  Total Number 
  Download to Board 
  Parameter 
  Auto Red Light 
  Red Light Display Outline
  Continuous Red Light Mode
Fig.9-13 Marking Dialog
Red Light: This item is used to mark the frame of the object without laser output and indicate the marking area so that users are convenient to orient the workpiece. This function is available in those laser machines which have red guide light. Key “F1” is the shortcut key of this function.
Mark: To execute marking. Key “F2” is the shortcut key of this function.
Continuous: Mark the current object repeatedly without stop.
Mark Selected: Only those selected objects would be marked.
Part: It indicates the total quantity of parts which have been marked.
Enable display outline: Check this function to display the outline of the figure when displaying red light.
Total Number: It indicates the total parts to be marked, which is ineffective under the mode of Continuous Marking. If the total part number is more than 1, the marking operation will not stop until the number of parts marked is equal to the total part number.
R: Marking parts reset.
Parameter: It is used for equipment setting.
：。
Download to Board: Download the current data to the board cache to start offline marking mode.

Enable Continuous Red Light Marking Mode: After selecting this function, returning to the software interface and clicking “Marking”, a dialog box as shown in Fig. 9-14 will appear. It will appear after each marking and red light preview will always exist.
[image: C:\Users\loop\Desktop\122.bmp122]
  Marking
  Red Light Indicating
Fig.9-14 Continuous Red Light Marking Mode

[bookmark: _Toc508712011][bookmark: _Toc64634146]10. Scanhead Calibration
[bookmark: _Toc485028181][bookmark: _Toc508712012][bookmark: _Toc64634147]10.1.Direction adjustment
The direction needs to be adjusted to the same direction as the drawing area before the calibration.
For example, draw a text in the drawing area, as shown below:
[image: C:\Users\loop\Desktop\3.bmp3]
Try to change the three checkmarks in the blue box below and mark until the marked figure matches the drawing area.
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 Configuration Parameters
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Y  Reverse Y 
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  Do Not Move 
  Galvanometer Center 
  Upper Left Corner of Object 
  Upper Right Corner of Object 
  Lower Right Corner of Object  
  Lower Left Corner of Object  
  Designated Position
1  Galvanometer 1
  Scale
2  Galvanometer 2
  Scale
  Equal Scale Method
  Password
  Password
  Use Configuration File
  Save Parameter As
  OK
  Close

[bookmark: _Toc508712013][bookmark: _Toc64634148][bookmark: OLE_LINK5][bookmark: OLE_LINK6]10.2. Manual Correction
Manual correction, enter from the right parameter (F3), as shown in the blue box in the figure below. By default, the galvanometer 1 corresponds to x and the galvo mirror 2 corresponds to y. If the xy swap is checked, the galvanometer 1 corresponds to y. Galvo 2 corresponds to x：
[image: C:\Users\loop\Desktop\2.bmp2]
[bookmark: _Toc508712014][bookmark: _Toc485028182] Configuration Parameter
  Area 
  Laser Control 
  Port  
  Advanced Parameter 
  Flight Marking
  Others 
  Red Light Indicator 
  Board Information
  Appearance 
  Area Size 
X  Offset X   
Y  Offset Y 
  Angle 
  Maximum Line Length 
  Use Correction File 
XY  XY Interchange 
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  Go to the Designated Position After Processing
  Do Not Move 
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  Upper Left Corner of Object 
  Upper Right Corner of Object 
  Lower Right Corner of Object  
  Lower Left Corner of Object  
  Designated Position
1  Galvanometer 1
  Scale
2  Galvanometer 2
  Scale
  Password
  Password
  Use Configuration File
  Save Parameter As
  OK
  Close

[bookmark: _Toc64634149]10.2.1.Shape adjustment
Adjust the curvature, trapezoidal deformation, parallelogram deformation.
Each time you change the curvature, trapezoid, and parallelogram parameters, click "Mark test rectangle" until it is square.
[bookmark: _Toc485028183][bookmark: _Toc508712015][bookmark: _Toc64634150]10.2.2.Zoom
According to the marked figure, measure the actual size,Zoom in/out, as shown below:
[image: C:\Users\loop\Desktop\10.bmp10]
  Calculation Scale
  Target Marking Size
  Actual Marking Size
  OK
  Close

In the first step, click on the “marking X scale line” and the software mark a line in X direction.
[bookmark: _Toc508712016][bookmark: _Toc64634151]10.2.3. Equal Scale Method
，。
For scenes with high precision requirements, you can use bisectrices to improve precision.

：，、、。
Note: Before using the equal scale, the bending, trapezoid and tilt deformation of the graph should be calibrated for the target precision range.

 “”，：
Check the “Equal Scale Method” and the following figure appears:
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 Configuration Parameter
  Area 
  Laser Control 
  Port  
  Advanced Parameter 
  Flight Marking
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  Red Light Indicator 
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  Appearance 
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X  Offset X   
  Angle 
  Maximum Line Length 
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XY  XY Interchange 
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  Do Not Move 
  Galvanometer Center 
  Upper Left Corner of Object 
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  Designated Position
1  Galvanometer 1
  Scale
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，5mm，120mm，25。
Set the number of bisectrices. For example, if you want to set 5mm/grid, set the number of bisectrices to 25 for the galvanometer with a working area of 120mm.

“X”，，“X”，。
Click “Mark X Bisectrix”, measure the distance from each bisectrix to the center line, and click “Set X Scale Parameter” to display the equal parameter interface.
[image: C:\Users\loop\Desktop\14.bmp14]
  Set Measurement Data 
  Setting Value 
  Actual Value 
[]  [Center Line]
  OK
  Close

，。“”。
Enter the measured value into the actual value column in the table of the equal parameter interface. Click “OK” to make the data effective.

，Y。
Similarly, set the Y equal value.

[bookmark: _Toc64634152]10.2.4.Save
Click "Save" to save the parameters using the current file name (or default file name); click "Save Data As" to save the file using another file name.
The saved file can be used for data correction of the marking software.

[bookmark: _Toc508712017][bookmark: _Toc64634153][bookmark: OLE_LINK7][bookmark: OLE_LINK8]10.3.  Nine Point Correction
。
It is used for occasions with high precision requirements.

 
Relevant Parameter Setting Before Correction

· ，。F3。
· Select in the marking parameter column on the right side of the main interface to open the parameter setting. The shortcut key is F3.

· ，120mm，120。
· Determine the field lens range, take 120mm as an example, change the parameter of area size to 120.

· ，。
· Set the galvanometer direction, as shown below.
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9-1 
Figure 9-1 Area Parameters

[bookmark: _Toc64634154]10.3.1 Start Correction

 “”，。
Enter "Nine Point Correction" from the menu and enter the nine point correction operation interface.

[image: C:\Users\loop\Desktop\21.bmp21]
  Initial Value Correction
  Nine Point Correction
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[bookmark: _Toc64634155][bookmark: _Toc508712019]  Galvanometer Correction
C:\Users\liuxy\Desktop\\\5.2.1.simple.build20191129.a\sea.cor
C:\Users\liuxy\Desktop\standard card\simplified version\
5.2.1.simple.build20191129.a\sea.cor

  Area Size 
  Verification Area
  Reset  
  Serial Number 
X  X Setting Value 
Y  Y Setting Value
X  X Actual Value 
Y  Y Actual Value
  Maximum Marking Graph  
  Stop Marking 
9  Marking 9 Point Rectangle 
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  Multi-dot Correction 
： Correction Points: 
  Correct Marking Size 
  Marking Correction Point 
  Marking Verification Graph 
  Close

[bookmark: _Toc64634156]10.3.2 Marking Correction Graphs

，100mm，。
Create a new correction file, then set the verification area to 100mm, and reset.

“9”，（x，y，），，，XY、X、Y，。
Click "Mark Nine Point Rectangle" to mark the following graph (x, y are used to illustrate the direction of the graph, but not the actual marking). Note that the direction and position of the short line segment and the triangle in the upper left corner must be consistent with the figure below. If it is not consistent, then adjust the XY interchange, X reverse and Y reverse parameters of the main interface until the marked graphs are in the same direction as the figure above.
[image: ]
	，。9，（5），：
When measuring the coordinates of points, the measurement error should be reduced as much as possible. Measure the coordinate values of 9 points in the above figure in turn, based on the center point (point 5), and the sequence number is as shown in the following figure: 
[image: ]
· （5），9，。XY，，。。9-51：（3）
· Take the cross center line (straight line and coordinate axis passing point 5) as the benchmark, measure the coordinate values of 9 points in turn and record. The measurement method is that one side of the vernier caliper coincides with the X-axis or Y-axis of the cross center line, and the other side coincides with the point to be measured. At this time, the reading is the correction value. Or use the quadratic element measurement. As shown in Figure 9-5, take the correction value of point 1 as an example: (it can be considered that the method of measuring for three times to take the average value, which will be more accurate)

· 4、5。2、3，4、5，。
· Fill the measured values into columns 4 and 5 of the data table. In which, the columns 2 and 3 are the set distances, and the columns 4 and 5 are the  corresponding actual marking distances. Note that the measured values are positive and negative.

· “”，（9dot.cor）9-9；
· Click “Save” to save the file (here save as 9dot. cor), as shown in Figure 9-9;

[image: C:\Users\loop\Desktop\112.png112]
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 Downloads
 Desktop 
 Last Visited Location
2345  2345 Downloads
 Library
 Videos
 Images
 Documents
 Music
 Name 
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  Type 
  Size 
（N）:   File Name (N): 
（T）：  Save Type (T):
 Hide Folders
  Save 
 Cancel
9-9 
Figure 9-9 Save Correction File

· ，“”，，：
· After saving, you can click the “Marking Verification Graph” to mark the corrected graphs, as shown below:

[image: ]

[bookmark: _Toc508712021][bookmark: _Toc64634157]10.3.3 Use Correction File
· ，9-10，，9dot.cor。
· Use the correction file in the configuration parameters, as shown in Figure 9-10 below. Check the use correction file and select the corresponding 9dot.cor file.
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[bookmark: _Toc508712022][bookmark: _Toc64634158]10.3.4Uniformity Correction and High Precision Adjustment

，，，x，y。
After the area correction, generally speaking, the precision can meet the requirements. If the uniformity can not meet the requirements, you can increase the equal scale correction in the x and y directions.

“”，：
Check the “Equal Scale Method” and the following interface appears:


10.3.4.1 X Scale Parameter Adjustment in X Direction

，“X”,X。
Step 1, click "Mark X Scale Line", the program marks the short line from short to long along the X-axis direction.

，“X”，。
Step 2, click “Set X Scale Parameter” to enter the scale value setting interface.

[image: C:\Users\loop\Desktop\14.bmp14]
  Set Measurement Data 
  Setting Value 
  Marking Value 
[]  [Center Line]
  OK
 Cancel

，（mm），，。
According to the sequence described in the figure, measure the distance (mm) from the short line to the center line in turn, fill it in the table on the right, and click OK to return to the main interface.

，“X”，X，（20 ，100mm，5mm），。，，，。
Step 3, click “Mark X Test Line”, the program marks a series of equal (20 equal parts for the size of the verification area, for example, if the verification area is 100 mm, the standard distance between adjacent bisectrices is 5 mm) short lines along the X-axis direction, and measures the distance between each short line and the center line. If a certain interval is greater than the standard equal distance, you need to increase the scale parameter distance; if it is smaller than the standard equal distance, you need to decrease the scale parameter.

，564.9，（6，7，8，9，10），529.9。2-13，“6”“7”。，“6”，4.95，30.8。
For example, if the measured spacing between line 5 and line 6 in the figure is 4.9, (assuming that 6, 7, 8, 9 and 10 are correct), then the distance between line 5 and the center line is 29.9. According to the data filled in Figure 2-13, this value is between “6” and “7”. According to the above rules, we need to adjust the data in the larger “6”, 4.9 is less than 5, so we need to reduce the original value of 30.8.

10.3.4.2 Y	Scale Parameter Adjustment in Y Direction

9.2.5.1。
The operation steps are the same as 9.2.5.1.
[bookmark: _Toc64634159]11. Help
[bookmark: _Toc64634160]11.1. About SEACAD
Click "About SEACAD" to display the software version information.

[bookmark: _Toc64634161]11.2. Reset Workspace Layout

，，；
If the software appears the interface display error, or abnormal window state and other problems, you can reset it to the initial state through this function;

，，。
If the user has used our marking software before, before updating the version, we recommend that the customer should reset the workspace payout first to avoid unpredictable disorder when the program is opened due to incompatibility.

：。
Note: To use this function, you need to restart the program manually.

[bookmark: _Toc64634162]11.3.  Board Registration
，。
If customers want to purchase or try out the boards, they need to register the boards according to the requirements of the sellers.

，（）（，），（），30，30；
As a restriction on customers and sellers, the program does not allow customers to mark (including red light) and save when it does not detect any board that has been officially registered (without restrictions on use) or registered during the probation period (with restrictions on service time, please consult the sellers for specific time), and the software will also have a 30-minute use restriction. After 30 minutes, the program will be forced to exit;

，，，（）。
When only one board is in the formal registration or probation period registration, the software will release all restrictions, but for the boards that have not been formally registered or have exceeded the probation period, they still cannot be marked and red light (only the relevant boards can be viewed in the board registration interface).

：
The board registration method is shown in the following figure:

[image: C:\Users\loop\Desktop\13.bmp13]
  Board Registration
  Serial Number 
  Version 
ID  Board ID
  Registration Code  
  State 
  Registered 
  Registration Key 
  Registration 
  Close

1. 。
2. 。
3. 。
4. ，。
1. Send the registration code to your supplier.
2. Obtain the registration key from the supplier.
3. Enter the registration key to the corresponding location of the registration key.
4. After clicking on the registration and waiting for a few seconds, the registration success box will pop up to confirm the completion of registration.

[bookmark: _Toc64634163]11.4. Help documentation
Click "Help Documentation" to open the software manual directly.
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